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 INTRODUCTION AND IMPORTANCE 
 Assalam-U-Alikum 
These notes are designed only to help the students. More notes, keys to the MCQs and material are on the 
way to you.  
 
There are other booklets to cover other areas of Information technology and other subjects of AFC and CAF. 
You may find them on GCA website and GCA official group on Facebook. You may also demand them from 
me. 
This booklet contain MCQs about MS Word 2010 
The topics covered are as under, 

1. Appearance 

2. Views 

3. File tab or backstage view 

4. Home tab 

5. Insert Tab 

6. Table tools (Design and layout tab) 

7. Status bar 

8. Quick access toolbar 

9. Shortcut keys and procedures (General) 

 
Any query and Suggestion is always welcomed. 
Regards 

Anwar Majid 

03083357385 

anwar-majid@hotmail.com 

Multan 
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How to memorize a lot of values or shortcut keys? 
MS word contains a lot of maximum, minimum or default values and shortcut keys. It is very 

difficult to remember all those by simple memorizing methods. But you can quickly go to the 

answer by some techniques which are as follows. 

1. Whenever you are asked a maximum value in inches it will be most probable that 

the value will be 22”. 

2. If you are asked minimum value in any unit, the probability that it will be zero is 

more than 90% or 0.9.  Otherwise it will be 1 or 0.5. 

3. If you are asked maximum value in points; it will be certain that the value will be 

1584. 

4. If you are asked a maximum unit less value like number of rows in table, and you are 

sure that it is greater than 1584 then it will be certainly 32,767. 

5. The default values of almost all parameters measured in inches will most probably 

be 0 or 1. 

6. Values or scaling given in %age can be memorized that if it contain negative values 

than it will be sure that the range will start from -100% and ends at 100%. 

7. Default values will of scaling will be probably near +100 or +1. 

8. If scaling does not contain negative values than range will start from 0 but there is 

more chances that it will end at 200 rather than 100. (at 400 in some exceptions) 

9. There are a lot of shortcut keys, you can’t remember all those. But you have to 

memorize those which are given by MS word in screen tips. (No need to search 

anymore in help or on internet) 

10. First 50 MCQs almost cover the above described criteria of shortcut keys. So ensure 

these keys never be slipped from your mind. 
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Self-Created MCQs Part 1st (Created by Anwar Majid) 

Note: All these MCQs are about MS word 2010 (specified). It should be always considered 
that all the MCQs contain that “MS Word 2010” words. Either these words are written or 
not. The MCQs may or may not correspond to other versions of MS word. Be Careful! 

1. Shortcut to open a new document while running MS word 2010? 
 (A) Ctrl + a  (B) Ctrl + O  (C) Ctrl + N  (D) Ctrl + P 
2. Shortcut to open already saved documents? 
 (A) Ctrl + a  (B) Ctrl + O  (C) Ctrl + N  (D) Ctrl + P 
3. To save a document which shortcut is used? 
 (A) Ctrl + a  (B) Ctrl + O  (C) Ctrl + N  (D) Ctrl + s 
4. To undo the last action the shortcut is? 
 (A) Ctrl + z  (B) Ctrl + y  (C) Ctrl + N  (D) Ctrl + P 
5. To redo the last action the shortcut is? 
 (A) Ctrl + z  (B) Ctrl + y  (C) Ctrl + N  (D) Ctrl + P 
6. To copy a selection the shortcut is? 
 (A) Ctrl + c  (B) Ctrl + x  (C) Ctrl + v  (D) Ctrl + P 
7. To cut a selection the shortcut is? 
 (A) Ctrl + c  (B) Ctrl + x  (C) Ctrl + v  (D) Ctrl + P 
8. To paste the copied or cut selection, the shortcut is? 
 (A) Ctrl + c  (B) Ctrl + x  (C) Ctrl + v  (D) Ctrl + P 
9. To exit the document the shortcut is? 
 (A) Alt + F4  (B) Alt + F5  (C) Ctrl + e  (D) Ctrl + x 
10. The shortcut to print is? 
 (A) Ctrl + F2 (B) Ctrl + P  (C) Ctrl + F5 (D) both a and b 
11. The shortcut to format painter is? 
 (A) Ctrl + shift+ v (B) Ctrl + alt+ x (C) Ctrl + shift+ c (D) Ctrl + alt + c 
12. To bold the text, the shortcut is? 
 (A) Ctrl + b  (B) Ctrl + c  (C) Ctrl + v  (D) Ctrl + t 
13. To italicize the text, the shortcut is? 
 (A) Ctrl + i  (B) Ctrl + b  (C) Ctrl + c  (D) Ctrl + v 
14. To under-line the text, the shortcut is? 
 (A) Ctrl + u  (B) Ctrl + v  (C) Ctrl + n  (D) Ctrl + l 
15. The growth of font by 1 point can be done by? 
 (A) Ctrl +}  (B) Ctrl + {  (C) Ctrl + >  (D) Ctrl + < 
16. The decrement in the font by 1 point can be done by? 
 (A) Ctrl + {  (B) Ctrl +}  (C) Ctrl + >  (D) Ctrl + < 
17. The shortcut key to get help is? 
 (A) F1  (B) F2  (C) F3  (D) F4 
18. The Shortcut to make the text as the sub-script of the pervious text? 
 (A) Ctrl + =  (B) Ctrl + + (C) Ctrl + -   (D) Ctrl + 0 
19. The shortcut to make the text as the super script of the pervious text? 
 (A) Ctrl + shift +)  (B) Ctrl + shift + + (C) Ctrl + shift+ - (D) Ctrl + 0 
20. Alignment of text to the left can be done by? 
 (A) Ctrl + l  (B) Ctrl + a  (C) Ctrl + m  (D) Ctrl + t 
21. The alignment of text to the center of the page can be done by? 
 (A) Ctrl + l  (B) Ctrl + c  (C) Ctrl + e  (D) Ctrl + r 
22. The alignment of text to the right of the page can be done by? 
 (A) Ctrl + r  (B) Ctrl + g  (C) Ctrl + h  (D) Ctrl + t 
23. The alignment of the text to justify the text equally to the right and left? 
 (A) Ctrl + j  (B) Ctrl + u  (C) Ctrl + s  (D) Ctrl + d 
24. The shortcut to show paragraph marks? 
 (A) Ctrl + shift+ /  (B) Ctrl + * (C) Ctrl + shift+ * (D) Ctrl + + 
25. The shortcut to find is? 
 (A) Ctrl + f  (B) Ctrl + h  (C) Ctrl + g  (D) Ctrl + n 
26. The shortcut to replace is? 
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 (A) Ctrl + f  (B) Ctrl + h  (C) Ctrl + g  (D) Ctrl + n 
27. The shortcut to insert a page break is? 

 (A) Ctrl + return  (B) Ctrl + backspace (C) Ctrl + p  (D) Ctrl + b 
28. The shortcut to insert a hyperlink is? 
 (A) Ctrl + k  (B) Ctrl + h  (C) Ctrl + l  (D) Ctrl + r 
29. The shortcut is to insert equation? 
 (A) Alt + + (B) Alt + =   (C) Ctrl + +  (D) Ctrl + = 
30. The shortcut to insert footnote is? 
 (A) Alt + Ctrl+ f  (B) Alt + Ctrl + o  (C) Alt + Ctrl + t (D) Alt + Ctrl + n 
31. The shortcut to insert endnote is? 
 (A) Alt + Ctrl+ e  (B) Alt + Ctrl + n  (C) Alt + Ctrl + d (D) Alt + Ctrl + o 
32. The shortcut to mark the entry of index is? 
 (A) Alt + Shift + m (B) Alt + Shift + x  (C) Alt + Shift + e (D) Alt + Shift + k 
33. The shortcut to mark the citation is? 
 (A) Alt + Shift + c (B) Alt + Shift + i  (C) Alt + Shift + t (D) Alt + Shift + n 
34. The shortcut to auto checks for errors when completing the mail merge is? 
 (A) Alt + Shift + c (B) Alt + Shift + h  (C) Alt + Shift + k (D) Alt + Shift + e 
35. The shortcut for the spelling and grammar check is? 
 (A) F6  (B) F7  (C) F8  (D) F9 
36. The shortcut to re-search is? 
 (A) Alt + r  (B) Alt + click (C) Alt + s  (D) Alt + e 
37. The shortcut to Thesaurus is? 
 (A) Shift + F6 (B) Shift + F7 (C) Shift + F8 (D) Shift + F9 
38. The shortcut to track the changes made to the documents is? 
 (A) Ctrl + shift + e (B) Ctrl + shift + t (C) Ctrl + shift+ m (D) Ctrl + 0 
39. The shortcut to “View Macros” is? 
 (A) Alt + F6  (B) Alt + F7  (C) Alt + F8  (D) Alt + F9 
40.  “Ctrl + S” has the function to save in MS word, the other shortcut for that is? 
 (A) Alt + shift + F4 (B) Alt + shift+ F3 (C) Alt + shift+ F2 (D) Alt + shift+ F9 
41. “Display the re-search task pane” is the function of? 
 (A) Alt + shift + F6 (B) Alt + shift+ F7 (C) Alt + shift+ F8 (D) Alt + shift+ F9 
42. “Alt+ Shift + F1” has the function assigned in MS word 2010 which is? 
 (A) Chose the save command (B) Display the research task pane  

(C) Go to the next field  (D) Go the pervious field 
43. “Go to the next field” function is assigned to the _____ combination of keys. 
 (A) Alt + shift + F1 (B) Alt + F1 (C) Alt + shift+ F2 (D) Alt + F2 
44. “Restoring the program” is an important procedure; which statement best defines it? 
 (A) It is about restoration of the deleted program from recycle bin  

(B) It is about decreasing the size of window of program appeared  
(C) It is about restoring the abilities of programs  
(D) None 

45. Restoration of MS Word windows can easily be done by? 
 (A) Alt + F1  (B) Alt + F2  (C) Alt + F4  (D) Alt + F5 
46. If your documents contain misspellings and grammatical errors and you want to find them, you can 

do it by simply pressing? 
 (A) Alt + F6  (B) Alt + F7  (C) F6  (D) F7 
47. There is ______ number of tabs in MS word 2010? 
 (A) 7  (B) 8  (C) 9  (D) 10 
48. Ribbons can be minimized by the key? 
 (A) Ctrl + F1 (B) Ctrl + F2 (C) Ctrl + F3 (D) Ctrl + F4 
49. Total number of views in which document of MS words can be viewed is? 
 (A) 5  (B) 4  (C) 6  (D) 3 
50. The default view of MS word 2010 is? 
 (A) Print Layout (B) Outline  (C) Draft  (D) Full-Screen 
51. The views of MS words includes EXCEPT? 
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 (A) Print Layout (B) web layout (C) Normal  (D) Full-Screen 
52. The minimum zoom level in which document of MS Word 2010 can be viewed is? 
 (A) 1%  (B) 20%  (C) 2%  (D) 10% 
53. The maximum zoom level in which document of MS Word 2010 can be viewed is? 
 (A) 1000%  (B) 200%  (C) 400%  (D) 500% 
54. The shortcut key of zoom in or out in MS word 2010 is by every 10%? 
 (A) Ctrl + 1  (B) Ctrl + wheel of mice (C) Ctrl + click (D) Ctrl + twice click 
55. The information about zooming is present on the ________ in MS Word 2010? 
 (A) Taskbar  (B) Tab bar  (C) Status bar (D) Toolbar 
56. The Words counted in the current document is shown on _______ in MS Word 2010? 
 (A) Taskbar  (B) Tab bar  (C) Status bar (D) Toolbar 
57. Proofing errors status is shown on ________ in MS Word 2010? 
 (A) Taskbar  (B) Tab bar  (C) Status bar (D) Toolbar 
58. Number of total pages and number of current page is shown on ______ in MS Word 2010? 
 (A) Taskbar  (B) Tab bar  (C) Status bar (D) Toolbar 
59. The current page and total pages or shown in which manner in MS Word 2010? 
 (A) Current/Total (B) Current of Total (C) Total/Current (D) Total of Current 
60. Line number can be? 
 (A) Continuous (B) Restated on each page (C) Restated on each section (D) all 
61. The default number of options ticked to be shown on status bar in MS Word 2010 is? 
 (A) 15  (B) 14  (C) 16  (D) 13 
62. The default number of options showed on the left side of the status bar is ____ in MS Word? 
 (A) 3  (B) 4  (C) 5  (D) 6 
63. The default number of options showed on the right side of the status bar is ____ in MS Word? 
 (A) 3  (B) 4  (C) 5  (D) 6 
64. Status bar is present in _____ corner of MS Word 2010? 
 (A) Upper  (B) Left  (C) Lower  (D) Right 
65. Quick Access Toolbar is present in _____ corner of MS Word 2010? 
 (A) Upper  (B) Left  (C) Lower  (D) Right 
66. Default gutter margin position is? 
 (A) Left  (B) Right  (C) Top  (D) Bottom 
67. By the default how many options are ticked to show on the quick access toolbar in MS word? 
 (A) 3  (B) 4  (C) 5  (D) 6 
68. The default options ticked to show on quick access toolbar in MS word 2010 includes EXCEPT? 
 (A) Undo  (B) Redo  (C) Open  (D) Save 
69. The number of undo actions can be done in MS word 2010 is? 
 (A)  3.    (B) Infinity   

(C)  500    (D) depends upon the availability of undoes 
70. The “redo” option is very useful for time saving; chose the statement which fails to state the role of 

redo command. 
 (A) As it names means it does the thing again which is done currently by you  

(B) It revert the action performed currently by performing undo command  
(C) It revert the action performed currently by performing delete command  
(D) It revert the action performed currently by performing cut command 
(E) All Except a 
(F) All 

71. “Save” button present on quick access toolbar performs? 
 (A) Save  (B) Save as  (C) both  (D) none 
72. The options which can be shown on quick access toolbar in MS word 2010 includes EXCEPT? 
 (A) Email  (B) Options  (C) Save  (D) Draw Table 
73. Categorize present under the tabs are? 
 (A) Menus  (B) Bars  (C) Ribbons (D) all 
74. Number of Color scheme for MS Word 2010? 
 (A) 3  (B) 4  (C) 5  (D) 6 
75. The default color scheme for MS Word 2010 is? 
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 (A) Blue  (B) Black  (C) Silver  (D) Gold 
76. Color Scheme of MS word 2010 includes EXCEPT? 
  (A) Blue  (B) Black  (C) Silver  (D) Gold 
77. ScreenTips Styles can take different views; which one is not its view? 
 (A) Show feature description in the ScreenTips   

(B) Don’t show feature description in the ScreenTips 
(C) Don’t Show ScreenTips   
(D) Show ScreenTips 

78.  (Arrow) it is mark for ______ when we show the paragraph marks. 
 (A) Spaces  (B) Line Breaks (C) Paragraphs  (D) Tabs 
79.  (Arrow)  it is mark tells that what key is pressed during typing when we show 

paragraph marks. 
 (A) Space  (B) Tab (C) Enter  (D) Ctrl + Enter 
80. (….. Dotted line) it is mark for ______ when we show the paragraph marks. 
 (A) Spaces  (B) Line Breaks (C) Paragraphs  (D) Tabs 
81. (….. Dotted line) it is mark tells that what key is pressed during typing when we show paragraph 

marks. 
 (A) Space  (B) Tab (C) Enter  (D) Ctrl + Enter 
82. Drawing and objects can be printed in the text. Chose the correct statement? 
 (A) Objects and drawings can’t be off in printing   

(B) Objects and drawings are always printed when present in the document  
(C) Objects and Drawings can be printed or not, its user will 
(D) All statements are correct 

83. When user orders not to print objects, _____ is shown in print in the place of objects. 
 (A) Empty Space (B) Blank Box (C) Filled Rectangle  (D) Open Area 
84. Trust Center of MS word contains a lot of settings about _______? 
 (A) Privacy (B) Protection (C) Trusted Programs (D) Macro Settings (E) all 
85. Settings of MS word Trust center can be changed. Statement is ______? 
 (A) Correct (B) Wrong (C) Either a or b (D) Neither a nor b 
86. Auto formatting is a very efficient procedure. It changes straight quotes instantly with ______? 
 (A) Inverted commas (B) Commas (C) Smart Quotes (D) none 
87. If you type hyphens it is automatically changed in _______by auto formatting? 
 (A) Minus sign  (B) Bracketed (C) Dash (D) Double hyphens 
88. Hyphens are changed in Dash instantly after typing this is done by? 
 (A) AutoFormat (B) AutoCorrect (C) Spelling &Grammar check (D) all 
89. Ordinals are converted into ______ by AutoFormat. 
 (A) Sub-script (B) Super-script (C) cardinals (D) numbers 
90. As you type a fraction (1/2) in MS word it converts it into? 
 (A) 0.5 (B) Fractions character (C) Fraction word (D) Fraction letter 
91. Internet and network paths are instantly converted into? 
 (A) Hyperlinks (B) formatted text (C) Text in blue (D) Italicized text 
92. The fonts and styles of pervious words or lines or applied as you continue to write, it is done by? 
 (A) AutoFormat (B) AutoCorrect (C) Spelling &Grammar check (D) all 
93. Left and first indent is marked by _____ when we type? 
 (A) AutoFormat (B) AutoCorrect (C) Spelling &Grammar check (D) all 
94. Indentation is of ____ types? 
 (A) 3  (B) 4  (C) 5   (D) 6 
95. Types of indentation includes all EXCEPT? 
 (A) Left indent (B) Right indent (C) First line indent  (D) Last line indent 
96. Ruler includes _____ type of indents. 
 (A) Left indent (B) Right indent (C) First line indent  (D) all 
97. The indent which is shown lonely on one side of the ruler. 
 (A) Left indent (B) Right indent (C) First line indent (D) Last line indent 
98. There are _____ numbers of rulers shown in the MS word 2010? 
 (A) 2 (B) 3 (C) 4  (D) 5 
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99. Indentation is shown on the ________ ruler? 
 (A) Vertical  (B) Horizontal (C) Diagonal  (D) all 
100. By double clicking on the rulers, which one of the following dialog box is appeared? 
 (A) Page layout (B) Page setup (C) Rulers & indentation  (D) none 
101. If your file contains grammatical or spelling mistakes, there is _____ color _____ is shown on the 

proofing book on status bar. Choose the best pair respectively. 
 (A) Red, Cross (B) Green, tick (C) Blue, Cross  (D) Green, Cross 
102. If your file contains no grammatical or spelling mistakes, there is _____ color _____ is shown on the 

proofing book on status bar. Choose the best pair respectively. 
 (A) Red, Cross (B) Green, ticks (C) Blue, tick.  (D) Yellow, tick 
103. Shortcut key to scroll down a page is? 
 (A) Page down  (B) Ctrl + Page down (C) End  (D) all 
104. Shortcut key to scroll up a page is? 
 (A) Page UP  (B) Ctrl + Page up  (C) Home  (D) all 
105. Option in the backstage view, which closes the document only, not the MS word 2010. 
 (A) Exit  (B) Close (C) Finish  (D) Done 
106. Option in the backstage view, which closes not only the document but also the MS word 2010. 
 (A) Exit  (B) Close (C) Finish  (D) Done 
107. The default gutter margin offered by MS word 2010 is? 
 (A) 0” (B) 1” (C) 2”  (D) 3” 
108. You can print max ____ numbers of pages on a single sheet from MS word 2010. 
 (A) 4 (B) 8 (C) 8  (D) 16 
109. You can print minimum ______ numbers of pages on a single sheet. 
 (A) 1 (B) 2 (C) 4  (D) 8 
110. The default margin settings offered by MS word 2010 is? 
 (A) Wide (B) Normal (C) Narrow  (D) Moderate 
111. Normal margin’s settings describe which settings? 
 (A) Top 1’’ Bottom 1” Left 1” Right 1” 
 (B) Top 0.5’’ Bottom 0.5” Left 0.5” Right 0.5” 
 (C) Top 0.25’’ Bottom 0.25” Left 0.25” Right 0.25” 
 (D) Top 1’’ Bottom 1” Left 0.75” Right 0.75” 
112. Narrow Margin’s settings describe which settings? 
 (A) Top 1’’ Bottom 1” Left 1” Right 1” 
 (B) Top 0.5’’ Bottom 0.5” Left 0.5” Right 0.5” 
 (C) Top 0.25’’ Bottom 0.25” Left 0.25” Right 0.25” 
 (D) Top 1’’ Bottom 1” Left 0.75” Right 0.75” 
113. Moderate Margin’s settings describe which setting? 
 (A) Top 1’’ Bottom 1” Left 1” Right 1” 
 (B) Top 0.5’’ Bottom 0.5” Left 0.5” Right 0.5” 
 (C) Top 0.25’’ Bottom 0.25” Left 0.25” Right 0.25” 
 (D) Top 1’’ Bottom 1” Left 0.75” Right 0.75” 
114. Wide Margin’s setting includes which setting? 
 (A) Top 2’’ Bottom 2” Left 2” Right 2” 
 (B) Top 1’’ Bottom 1” Left 2” Right 2” 
 (C) Top 2’’ Bottom 2” Left 1” Right 1” 
 (D) Top 1’’ Bottom 1” Left 0.5” Right 0.5” 
115. The default margin’s setting of MS Word 2003? 
 (A) Top 1’’ Bottom 1” Left 1.25” Right 1.25” 
 (B) Top 0.5’’ Bottom 0.5” Left 0.5” Right 0.5” 
 (C) Top 1.25’’ Bottom 1.25” Left 1.25” Right 1.25” 
 (D) Top 1’’ Bottom 1” Left 0.5” Right 0.5” 
116. Mirrored Margin’s settings have the same parameters with other margin’s settings; these 

parameters includes? 
 (A) Top, Bottom (B) Left, Right (C) Inside, outside  (D) all 



Prof. M. Javed Akhtar  In the name of ALLAH M S  W O R D  2 0 1 0  

P a g e  | 8 03083357385 Anwar Majid 
 

117. Mirrored Margin’s settings have the different parameters with other margin’s settings; these 
parameters includes? 

 (A) Top, Bottom (B) Left, Right (C) Inside, outside  (D) all 
118. Mirrored Margin’s settings describe which one of the following settings? 
 (A) Top 1’’ Bottom 1” inside 1.25” outside 1.25” 
 (B) Top 1’’ Bottom 1” inside 1.25” outside 1” 
 (C) Top 1.25’’ Bottom 1.25” inside 1.25” outside 1.25” 
 (D) Top 1’’ Bottom 1” inside 0.5” outside 0.5” 
119. the most heighted paper size offered by MS word 2010 is? 
 (A) Legal (B) A4 (C) Tabloid  (D) A5 
120. Default paper size of MS word 2010 is? 
 (A) Legal (B) A4 (C) A5  (D) Letter 
121. Default Paper size of MS word 2010 is? 
 (A) 11” x 17” (B) 8.5” x 11” (C) 8.27” x 11.69”  (D) 8.5” x 14” 
122. The size of Letter paper is? 
 (A) 11” x 17” (B) 8.5” x 11” (C) 8.27” x 11.69”  (D) 8.5” x 14” 
123. The size of A4 paper is? 
 (A) 11” x 17” (B) 8.5” x 11” (C) 8.27” x 11.69”  (D) 8.5” x 14” 
124. The size of legal paper is? 
 (A) 11” x 17” (B) 8.5” x 11” (C) 8.27” x 11.69”  (D) 8.5” x 14” 
125. The size of tabloid paper is? 

(A) 11” x 17” (B) 8.5” x 11” (C) 8.27” x 11.69”  (D) 8.5” x 14” 
126. The size of A3 paper is? 
 (A) 11.69” x 17” (B) 8.5” x 11.69” (C) 8.27” x 11.69”  (D) 11.69” x 16.54” 
127. The size of A5 paper is? 
 (A) 5.83” x 8.27” (B) 10.12” x 14.33” (C) 7.17” x 10.12”  (D) 3.94” x 5.83” 
128. The size of B4 (JIS) paper is? 
 (A) 5.83” x 8.27” (B) 10.12” x 14.33” (C) 7.17” x 10.12”  (D) 3.94” x 5.83” 
129. The size of B5 (JIS) paper is? 
 (A) 5.83” x 8.27” (B) 10.12” x 14.33” (C) 7.17” x 10.12”  (D) 3.94” x 5.83” 
130. The size of Japanese Postcard paper is? 
 (A) 5.83” x 8.27” (B) 10.12” x 14.33” (C) 7.17” x 10.12”  (D) 3.94” x 5.83” 
131. In Paper sizes which one is correct arrangement of parameters shown by MS word 2010? 
 (A) Height x Width (B) Width x Height (C) Breadth x Height (D) Height x Breadth 
132. There are ____ numbers of orientation of paper in MS word 2010. 
 (A) 2 (B) 3 (C) 4  (D) 5 
133. Which one of the following is the Orientation of page not offered by MS word 2010? 
 (A) Portrait  (B) Landscape (C) both  (D) none  
134. Maximum number of columns in which MS word page can be divided is? 
 (A) 12 (B) 13 (C) 14  (D) 15 
135. When divide page in ____ or more columns the default width of column remains constant. 
 (A) 7 (B) 8 (C) 9  (D) 10 
136. When divide page in seven or more columns the default width column remains constant which is? 
 (A) 0.50” (B) 1.50” (C) 2.50”  (D) 3.50” 
137. When divide page in ____ or more columns the default width of column remain constant but default 

spacing tends to vary. 
 (A) 7 (B) 8 (C) 9  (D) 10 
138. By the default MS word page is divided into ____ number of columns? 
 (A) 0 (B) 1 (C) 2  (D) 3 
139. There are _____ numbers of columns presets offered by MS word 2010 for a single page. 
 (A) 3 (B) 4 (C) 5  (D) 6 
140. If you divide the page in more than one column, then the column width and spacing for all columns 

_______.  
 (A) Is Fixed (B) can be changed  (C) both  (D) none 
141. the most common Paper size offered for printing is? 
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 (A) Letter (B) A4 (C) Legal  (D) A3 
142. A printer can print on ______ side of paper? 
 (A) Single (B) Double (C) Triple  (D) both a and b 
143. If you want to print on both sides of the paper, the paper for 2nd side printing is adjusted _______? 
 (A) Automatically (B) Manually (C) Either a or b  (D) Neither a nor b 
144. Collated and un-collated are important concepts; choose the statement which best describe collated 

copies concept. 
 (A) Copies are printed in a manner of 1 2 3, 1 2 3, 1 2 3  

(B) Copies are printed in a manner of 1 1 1, 2 2 2, 3 3 3  
(C) Both  (D) none 

145. Collated and un-collated are important concepts; choose the statement which best describe un-
collated copies concept. 

 (A) Copies are printed in a manner of 1 2 3, 1 2 3, 1 2 3  
(B) Copies are printed in a manner of 1 1 1, 2 2 2, 3 3 3  
(C) Both  (D) none 

146. The shortcut to show print preview is? 
 (A) Ctrl+ P (B) Ctrl+ T (C) Alt+ P  (D) Alt+ T 
147. When a document is marked as final, the icon of “marked as final” is shown on? 
 (A) Toolbar  (B) Taskbar (C) Status bar  (D) Menu bar 
148. You can protect a MS word document in ______ number of ways. 
 (A) 3 (B) 4 (C) 5  (D) 6 
149. When you are saving a document; “Save as Type” box shows _____ of file. 
 (A) Extension (B) name (C) Size  (D) Properties 
150. You can share word file by using ____ numbers of methods. 
 (A) 3 (B) 4 (C) 5  (D) 6 
151. There are _____ numbers of Ribbons under home tab. 
 (A) 3 (B) 4 (C) 5  (D) 6 
152. Ribbons of home tab includes all EXCEPT? 
 (A) Clipboard (B) Paragraph (C) Indentation  (D) Styles 
153. Choose the option which only includes the Ribbons of Home Tab. 
 (A) Clipboard, Font, indentation, Paragraph, Editing, Styles 

(B) Clipboard, Font, Caption, Paragraph, Editing, Styles  
(C) Clipboard, Font, indentation, Caption, Editing, Styles   
(D) Clipboard, Font, Paragraph, Editing, Styles 

154. The option which is not included in the Clip board ribbon? 
  (A) Cut (B) Format Painter (C) Paste  (D) Copy (E) none 
155. There are ___ numbers of tabs in MS word 2010. 
 (A) 10 (B) 9 (C) 8  (D) 7 
156. If you want to delete some of the objects or text placed in your document, you can do it by? 
 (A) Select the text and press delete to remove it from the document 
 (B) Select the text or object and cut it from the document  

(C) After selecting the text go to clipboard ribbon and press cut button  (D) all 
157. Clipboard can be opened by? 
 (A) Pressing Ctrl+ C twice (B) Pressing Ctrl+ V twice  

(C) Clicking the arrow button placed on the bottom of the Clipboard ribbon  (D) both a and c 
158. The maximum font size which can be applied in MS word 2010 is? 
 (A) 1635 (B) 1638 (C) 1640  (D) 1645 
159. The minimum font size which can be applied in MS word 2010 is? 
 (A) 0.5 (B) 1 (C) 2  (D) 4 
160. The default font size of MS word 2010 is? 
 (A) 8 (B) 10 (C) 11  (D) 12 
161. The default font of MS Word 2010 is? 
 (A) Time New Roman (B) Calibri (C) Cambria  (D) Arial 
162. Which one of the following group represents the theme fonts of MS word 2010? 
 (A) Times New Roman, Arial  (B) Calibri, Cambria   
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(C) Times New Roman, Cambria  (D) Arial, Calibri 
163. The default background writing color for MS word 2010 is? 
 (A) Blue (B) Yellow (C) Red  (D) Green 
164. The default writing color (font color) for MS word 2010 is? 

(A) Blue (B) Yellow (C) Red  (D) Green 
165. “Clear Formatting” option is present in the following tab. 
 (A) File (B) Home (C) Insert  (D) Review 
166. “Clear Formatting” option is present in the following Ribbon. 
 (A) Paragraph (B) Font (C) Editing  (D) Caption 
167. There are _____ numbers of cases w.r.t capitalization of spelling or alphabets. 
 (A) 4 (B) 3 (C) 6  (D) 5 
168. Which one of the following describes correctly the sentence case? 
 (A) Select The Text And Press Delete To Remove It From The Document 
 (B) SELECT THE TEXT OR OBJECT AND CUT IT FROM THE DOCUMENT  

(C) after selecting the text go to clipboard ribbon and press cut button   
(D) Remove the text before copying or cutting it 

169. Which one of the following describes correctly the lower case? 
 (A) Select The Text And Press Delete To Remove It From The Document 
 (B) SELECT THE TEXT OR OBJECT AND CUT IT FROM THE DOCUMENT  

(C) after selecting the text go to clipboard ribbon and press cut button   
(D) Remove the text before copying or cutting it 

170. Which one of the following describes correctly the upper case? 
 (A) Select The Text And Press Delete To Remove It From The Document 
 (B) SELECT THE TEXT OR OBJECT AND CUT IT FROM THE DOCUMENT  

(C) after selecting the text go to clipboard ribbon and press cut button   
(D) Remove the text before copying or cutting it 

171. Which one of the following describes correctly the toggle case? 
 (A) Select The Text And Press Delete To Remove It From The Document 
 (B) sELECT tHE tEXT oR oBJECT aND cUT iT fROM tHE dOCUMENT  

(C) after selecting the text go to clipboard ribbon and press cut button   
(D) Remove the text before copying or cutting it 

172. Which of the following is not the font style? 
 (A) Regular  (B) Italics (C) Underlined  (D) Bold 
173. Which one of the following is underlined when we Press Ctrl+ U from keyboard? 
 (A) Words (B) Spaces (C) Both  (D) none 
174. Which one of the following can be underlined? 
 (A) Words (B) Spaces (C) Both  (D) none 
175. Underlining of words can be done in ______ color. 
 (A) Black (B) Blue (C) Red  (D) all 
176. Minimum value in the character Spacing scale is? 
 (A) 50% (B) 33% (C) 25%  (D) 12.5% 
177. Maximum value in the character Spacing scale is? 
 (A) 50% (B) 100% (C) 200%  (D) 400% 
178. There are _____ types of character spacing possible in MS word 2010. 
 (A) 2 (B) 3 (C) 4  (D) 5 
179. Which one of the following is not a character spacing option in MS word 2010? 
 (A) Raised  (B) Condensed (C) Expanded  (D) Normal 
180. If we chose the Expanded Character spacing, what is the maximum degree of expanding in points? 
 (A) 1580 (B) 1584 (C) 1588  (D) 1590 
181.  If we chose the Condensed Character spacing, what is the maximum degree of condensing in 

points? 
 (A) 1580 (B) 1584 (C) 1588  (D) 1590 
182. The Default scale of character spacing is? 
 (A) 50% (B) 100% (C) 200%  (D) 400% 
183. Which one is the default character spacing in MS word 2010? 
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 (A) Raised (B) Condensed (C) Expanded  (D) Normal 
184. If we chose the Condensed Character spacing, what is the default degree of condensing in points? 
 (A) 1 (B) 2 (C) 3  (D) 4 
185. If we chose the Expanded Character spacing, what is the default degree of expanding in points? 
 (A) 1 (B) 2 (C) 3  (D) 4 
186. There are ____ numbers of Positions available for Characters in a line for MS word 2010. 
 (A) 1 (B) 2 (C) 3  (D) 4 
187. The Position of characters includes all EXCEPT? 
 (A) Condensed (B) Raised (C) Lowered  (D) Normal 
188. The default position of characters in MS word 2010 is? 
 (A) Condensed (B) Raised (C) Lowered  (D) Normal 
189. If we chose the Raised Character Position, what is the default degree of Raising in points? 
 (A) 1 (B) 2 (C) 3  (D) 4 
190. the most wide paper size is? 
 (A) A3 (B) A4 (C) Legal  (D) Tabloid 
191. If we chose the Lowered Character Position, what is the default degree of Lowering in points? 
 (A) 1 (B) 2 (C) 3  (D) 4 
192. If we chose the Raised Character Position, what is the Maximum degree of Raising in points? 
 (A) 1580 (B) 1584 (C) 1588  (D) 1592 
193. If we chose the Lowered Character Position, what is the Maximum degree of Lowering in points? 
 (A) 1580 (B) 1584 (C) 1588  (D) 1592 
194. For Font Color, there are _____ numbers of theme color. 
 (A) 10 (B) 12 (C) 14  (D) 15 
195. For Font Color, there are _____ numbers of standard color. 
 (A) 10 (B) 12 (C) 14  (D) 15 
196. Other font colors are the shades of ____ colors. 
 (A) Theme (B) Standard (C) both  (D) none 
197. There are ____ numbers of color model offered by MS word 2010. 
 (A) 1 (B) 2 (C) 3  (D) 4 
198. When we are applying solid fill to objects, the minimum transparency level can be? 
 (A) 25% (B) 12.5% (C) 5%  (D) 0% 
199. When we are applying solid fill to objects, the maximum transparency level can be? 
 (A) 250% (B) 125% (C) 200%  (D) 100% 
200. There are ____ numbers of type of gradient fill. 
 (A) 1 (B) 2 (C) 3  (D) 4 
201. The type of gradient fill includes all EXCEPT? 
 (A) Path (B) Linear (C) Rectangular  (D) Radial (E) none 
202. In case of Linear Gradient Fill, the minimum angle offered by MS word 2010 is? 
 (A) 00 (B) 100 (C) 50  (D) 40 

203. In case of Linear Gradient Fill, the maximum angle offered by MS word 2010 is? 
 (A) 3600 (B) 3500 (C) 359.50  (D) 358.50 
204. Which one of the following Gradient fill only involves angle parameter? 
 (A) Path (B) Linear (C) Rectangular  (D) Radial (E) none 
205. The brightness level of Gradient fill can take minimum value of? 
 (A) -200% (B) -100% (C) 0%  (D) 100% 
206. The brightness level of Gradient fill can take maximum value of? 
 (A) 200% (B) 100% (C) 0%  (D) 300% 
207. The shortcut key of font dialog box is? 
 (A) Ctrl+ F (B) Alt+ F (C) Ctrl+ D  (D) Ctrl+ N 
208. An option given in font dialog box is “Small Caps”, a check box, its function is to? 
 (A) It changes the alphabets in small letters 
 (B) It changes the alphabets in capital letter but with small font 
 (C) It changes the alphabets into small letter with small font 
  (D) It does not changes the alphabets case but only makes it small in font size 
209. The Paper having more area for writing is? 
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 (A) A4 (B) A3 (C) A5  (D) Legal 
210. “Cover page” option is present under _____ tab. 
 (A) File (B) Home (C) Insert  (D) Page layout 
211. “Add blank page” option is present under ____ tab. 
 (A) File (B) Home (C) Insert  (D) Page layout 
212. Add page break option is present under ______ tab. 
 (A) File (B) Home (C) Insert  (D) View 
213. Table option is present under ____ tab. 
 (A) File (B) Home (C) Insert  (D) View 
214. “Cover page” option is present under _____ ribbon. 
 (A) Pages (B) Table (C) Links  (D) Illustrations 
215. “Add Blank page” option is present under ____ ribbon. 
 (A) Pages (B) Table (C) Links  (D) Illustrations 
216. Add page break option is present under ______ ribbon. 
 (A) Pages (B) Table (C) Links  (D) Illustrations 
217. Table option is present under _____ ribbon. 
 (A) Pages (B) Table (C) Links  (D) Illustrations 
218. “Paste special” contain one of the option is “Merge formatting” it meant to? 

(A) Chose the formatting and color scheme which is average or better of the source and 
destination  

(B) Select the formatting of the source but changes the color scheme of source 
(C) Select the color scheme of source and changes the formatting of source 
(D) Select the color scheme and formatting as per destination’s one 

219. “Keep text only” option of paste special refers to? 
 (A) Deletion of formatting and keep the text with default formatting 
  (B) Deletion of formatting and keep the text with current formatting  

(C) Deletion of formatting and keep the text with source formatting   
(D) Deletion of formatting and keep the text with Original formatting 

220. “Keep source formatting” is the option of paste special referring to? 
 (A) Keep the source color scheme and formatting while retaining the source text 
 (B) Keep the destination color scheme and formatting while retaining the source text 
 (C) Keep the destination color scheme and formatting while retaining the destination text  

(D) Keep the destination color scheme and formatting while retaining the source text 
221.  Consider you have made some part of text of your document hidden, which method will retrieve it? 
 (A) Select the paragraph mark to show hidden text then select the text and mark it hidden 
 (B) Select the text by going to the review tab in hidden ribbon and select hidden  

(C) Chose the hidden from edit menu after being found the hidden text 
(D) all 

222. MS word offer up to _____ number of heading styles. 
 (A) 10 (B) 9 (C) 8  (D) 7 
223. When you do format an object by a texture fill, the texture fill can be? 
 (A) Provided by MS Word itself; Built-in textures 
 (B) A Picture provided by the user 
 (C) A clipart provided by MS Word 

(D) A Clipboard item (E) all (F) all except d 
224. There are ____ numbers of fill offered for objects by MS Word 2010. 
 (A) 1 (B) 2 (C) 3  (D) 4 
225. When you add picture or texture fill, to any object, tiling option under it shows how much plane of 

picture. 
 (A) 1 (B) 2 (C) 3  (D) 4 
226. The x plane of texture fill can have max up to _____ offset in points? 
 (A) 1580 (B) 1584 (C) 1588  (D) 1590 
227. The y plane of texture fill can have max up to _____ offset in points? 
 (A) 1580 (B) 1584 (C) 1588  (D) 1590 
228. There are ____ numbers of line types offered by MS word 2010 for objects. 
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 (A) 1 (B) 2 (C) 3  (D) 4 
229. The line color includes all EXCEPT? 
 (A) Solid line (B) Gradient Line (C) Texture line  (D) none 
230. The “line styles” of object or text can be changed; how much max width the line can take in points? 
 (A) 1580 (B) 1584 (C) 1588  (D) 1590 
231. The “line styles” of object or text can be changed; how much types of a line can be compounded. 
 (A) 2 (B) 3 (C) 4  (D) 5 
232. The compounding of lines of object or text includes all EXCEPT? 
 (A) Simple (B) Double (C) Triple  (D) Tetrad 
233. The cap of line of text or object can be? 
 (A) Round (B) Square (C) Flat  (D) Rectangle 
234. The joint type of line of objects includes all EXCEPT? 
 (A) Round (B) Square (C) Bevel  (D) Miter 
235. The shadow of the object or text can take value maximum ______ % of original one? 
 (A) 100 (B) 200 (C) 300  (D) 400 
236. The shadow of the object or text can take value minimum ______ % of original one if it is active? 
 (A) 0 (B) 1 (C) 10  (D) 25 
237. The shadow blur of the shadow of the object or text can take value b/w in points? 
 (A) 0-100 (B) 0-72 (C) 0-1584  (D) 0-200 
238. The default case w.r.t Capitalization of alphabets is in MS 2010? 
 (A) Lower case (B) Upper (C) Sentence  (D) Toggle 
239. the most common used case w.r.t Capitalization of alphabets is?  
 (A) Lower case (B) Upper (C) Sentence  (D) Toggle 
240. The default font style of MS word 2010 is? 
 (A) Regular  (B) Italics (C) Underlined  (D) Bold 
241. The color model includes all EXCEPT? 
 (A) RGB (B) STD (C) HSL  (D) none 
242. The default color model for MS word 2010 is? 
 (A) RGB (B) STD (C) HSL  (D) none 
243. When we are applying solid fill to objects, the default transparency level is? 
 (A) 20% (B) 10% (C) 0%  (D) 30% 
244. Which one of the following is default Gradient Fill? 
 (A) Path (B) Linear (C) Rectangular  (D) Radial (E) none 
245. In case of Linear Gradient Fill, the default angle offered by MS word 2010 is? 
 (A) 3600 (B) 00 (C) 359.50  (D) 900 

246. The brightness level of Gradient fill has the default value of? 
 (A) -200% (B) -100% (C) 0%  (D) 100% 
247. The default fill offered by MS word for objects is? 
 (A) No fill (B) Solid (C) Gradient  (D) Texture 
248. The default Gradient fill for objects is? 
 (A) Linear (B) Rectangular (C) Radial  (D) Texture 
249. The default color for line of object is? 
 (A) Solid line (B) Gradient line (C) Texture line  (D) none 
250. The angle of the shadow can take value b/w? 
 (A) 00-3600 (B) 00-3580 (C) 00-3590  (D) 00-359.50 

251. The distance of the shadow from original object can take value b/w in points? 
 (A) 0-200 (B) 0-400 (C) 0-100  (D) 0-300 
252. The default setting of the shadow of the objects is that? 
 (A) Applied (B) not-applied (C) both  (D) none 
253. The reflection of the object or text can take value maximum ______ % of original one? 
 (A) 100 (B) 200 (C) 300  (D) 400 
254. The reflection of the object or text can take value minimum ______ % of original one if applied? 
 (A) 0 (B) 1 (C) 10  (D) 25 
255. The distance of the reflection from original object can take value b/w in points? 
 (A) 0-200 (B) 0-400 (C) 0-100  (D) 0-300 



Prof. M. Javed Akhtar  In the name of ALLAH M S  W O R D  2 0 1 0  

P a g e  | 14 03083357385 Anwar Majid 
 

256. The reflection blur of the reflection of the object or text can take value b/w in points? 
 (A) 0-100 (B) 0-72 (C) 0-1584  (D) 0-200 
257. The default setting of the reflection of the objects is that? 
 (A) Applied (B) not-applied (C) both  (D) none 
258. The glow size of the object can take value b/w in points? 
 (A) 0-150 (B) 0-50 (C) 0-250  (D) 0-350 
259. The soft-edges size of the object can take value b/w in points? 
 (A) 0-200 (B) 0-100 (C) 0-400  (D) 0-300 
260. The default transparency level for the glow of the objects? 
 (A) 50% (B) 60% (C) 70%  (D) 0% 
261. The bevel of 3-D format of objects has height and width parameters of top and bottom. These can 

take value b/w in points? 
 (A) 0-1580 (B) 0-1584 (C) 0-1588  (D) 0-1590 
262. Depth of 3-D format of object can take value b/w? 
 (A) 0-1580 (B) 0-1584 (C) 0-1588  (D) 0-1590 
263. Contour of 3-D format of object can take value b/w? 
 (A) 0-1580 (B) 0-1584 (C) 0-1588  (D) 0-1590 
264. When we apply 3-D rotation of object on x-plane, the objects rotates? 
 (A) Left, Right (B) up, down (C) Clockwise, Counter clockwise (D) none 
265. When we apply 3-D rotation of object on y-plane, the objects rotates? 
 (A) Left, Right (B) up, down (C) Clockwise, Counter clockwise (D) none 
266. When we apply 3-D rotation of object on z-plane, the objects rotates? 
 (A) Left, Right (B) up, down (C) Clockwise, Counter clockwise (D) none 
267. The 3-D rotation of objects can be done b/w the values? 
 (A) 00-3600 (B) 00-3580 (C) 00-3590  (D) 00-359.90 

268. The 3-D rotation has parameters? 
 (A) 1 (B) 2 (C) 3  (D) 4 
269. The 4th parameter of 3-D rotation is? 
 (A) Perspective (B) Respective (C) irrespective  (D) susceptive 
270. The perspective parameter of 3-D rotation is measured in? 
 (A) Points (B) Degrees (C) Inches  (D) Centimeters 
271. The perspective parameter of 3-D rotation can take value b/w? 
 (A) 00-1000 (B) 00-1100 (C) 00-1200  (D) 00-1800 

272. The distance of object from ground in case of 3-D rotation can take maximum value of in points? 
 (A) 3000 (B) 3200 (C) 3500  (D) depends upon shape 
273. All picture corrections parameters can take same value, they can take value b/w? 
 (A) 0 to 200% (B) 0 to 100% (C) -100% to 100%  (D) -200% to 200% 
274. Picture color saturation can take value b/w? 
 (A) 0-200% (B) 0-100% (C) 0-400%  (D) 0-300% 
275. The picture color tone temperature can take value b/w? 
 (A) 1,500-10,000 (B) 1,000-10,000 (C) 1,500-11,500  (D) 2,000-11,500 
276. Kerning for fonts can take value b/w in points? 
 (A) 10-100 (B) 8-72 (C) 10-72  (D) 8-100 
277. Ligatures can be? 
 (A) Standard (B) Standard and contextual (C) Historical and dictionary  (D) all 
278. Number Spacing can be? 
 (A) Default (B) Proportional (C) Tabular  (D) all 
279. Number Form can be? 
 (A) Default (B) Lining  (C) Old-style  (D) all 
280. Text fill can be? 
 (A) Solid Fill (B) Gradient Fill (C) Texture Fill  (D) both a and b (E) all 
281. Text outline can be? 
 (A) Solid line (B) Gradient line (C) Texture line  (D) both a and b (E) all 
282. If we click on increase or decrease font button of the font ribbon, it increases or decreases font by 

_______points every time? 
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 (A) 1 (B) 2 (C) 5  (D) 10 (e) variable 
283. There are ____ numbers of alignments of paragraphs found in MS word 2010. 
 (A) 1 (B) 2 (C) 4  (D) 6 
284. Alignments of paragraphs includes EXCEPT? 
 (A) Left (B) Right (C) Center  (D) justified (E) none 
285. The default value for kerning of fonts is? 
 (A) 8 (B) 10 (C) 11  (D) 12 (e) as per current text font 
286. MS word offer _____ list levels of bullets and numbering or multi-level list maximum. 
 (A) 10 (B) 9 (C) 8  (D) 7 
287. Default bullet offered by MS word 2010 is? 
 (A) An empty circle (B) A filled box (C) A filled circle  (D) none 
288. MS word can start numbering from _____ number. 
 (A) 0 (B) 1 (C) 2  (D) 3 (e) any number 
289. MS Word offer _____ numbering by the default.  
 (A) 1,2,3 (B) i,ii,iii (C) a,b,c  (D) I,II,III 
290. Bullets and numbering are present under _____ tab. 
 (A) Home (B) Insert  (C) View  (D) Review 
291. There are _____ numbers of multi-level lists offered by MS word 2010? 
 (A) 4 (B) 5 (C) 6  (D) 7 
292. Multi-level list can contain only? 
 (A) Bullets (B) Numbering (C) both  (D) none 
293. MS word offer _____ levels of multi-level lists by the default. 
 (A) 10 (B) 9 (C) 8  (D) 7 
294. Bullets and numbering is written automatically if already applied when we give ____ break. 
 (A) Page (B) Paragraph (C) Line  (D) Word 
295. Bullets and numbering is written automatically if already applied when we press ______ key. 
 (A) Return (B) Ctrl+ Enter (C) Shift+ Enter  (D) Alt+ Enter 
296. Multi-level list starts from? 
 (A) Number (B) Bullet (C) both may be  (D) none 
297. There are ____ numbers of multi-level list which contain only numbers offered by the default. 
 (A) 4 (B) 5 (C) 6  (D) 7 
298. There are ____ numbers of multi-level list which contain only bullets offered by the default. 
 (A) 3 (B) 2 (C) 1  (D) 0 
299. If we want to apply numbering automatically; we will write (number.) and then press _____ key? 
 (A) Return (B) Enter (C) Tab  (D) Shift 
300. The default space b/w “number or bullet” and the “text” is? 
 (A) 0.2” (B) 0.25” (C) 0.3”  (D) 0.5” 
301. If we apply numbers or bullets the text indent will be ______ by the default. 
 (A) 0.2” (B) 0.25” (C) 0.3”  (D) 0.5” 
302. If we apply numbers or bullets, the bullet indent will be ______ by the default. 
 (A) 0.2” (B) 0.25” (C) 0.3”  (D) 0.5” 
303. At list level 2, the text indent by the default will be? 
 (A) 2” (B) 1” (C) 0.3”  (D) 0.5” 
304. At list level 2, the bullet or number indent by the default will be? 
 (A) 0.6” (B) 0.75” (C) 0.8”  (D) 0.9” 
305. As we apply number or bullets, the default list level is applied, which is? 
 (A) 2 (B) 3 (C) 4  (D) 1 
306. At list level 3, the text indent by the default will be? 
 (A) 1.5” (B) 1” (C) 1.3”  (D) 2.5” 
307. At list level 3, the bullet or number indent by the default will be? 
 (A) 1.6” (B) 1.75” (C) 1.8”  (D) 1.25” 
308. At list level 4, the text indent by the default will be? 
 (A) 2” (B) 1” (C) 3”  (D) 4” 
309. At list level 4, the bullet or number indent by the default will be? 
 (A) 1.6” (B) 1.75” (C) 1.8”  (D) 1.9” 
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310. At list level 5, the text indent by the default will be? 
 (A) 2.5” (B) 3.5” (C) 2.3”  (D) 4.5” 
311. At list level 5, the bullet or number indent by the default will be? 
 (A) 2.6” (B) 2.75” (C) 2.25”  (D) 2.5” 
312. At list level 6, the text indent by the default will be? 
 (A) 4” (B) 3” (C) 5”  (D) 6” 
313. At list level 6, the bullet or number indent by the default will be? 
 (A) 2.87” (B) 2.75” (C) 2.8”  (D) 2.9” 
314. At list level 7, the text indent by the default will be? 
 (A) 3.75” (B) 3.25” (C) 3.5”  (D) 3.37” 
315. At list level 7, the bullet or number indent by the default will be? 
 (A) 3.75” (B) 3.25” (C) 3.5”  (D) 3.37” 
316. At list level 8, the text indent by the default will be? 
 (A) 4” (B) 5” (C) 6”  (D) 7” 
317. At list level 8, the bullet or number indent by the default will be? 
 (A) 3.75” (B) 3.5” (C) 3.37”  (D) 3.25” 
318. At list level 9, the text indent by the default will be? 
 (A) 4.75” (B) 4.25” (C) 4.5”  (D) 4.37” 
319. At list level 9, the bullet or number indent by the default will be? 
 (A) 4.75” (B) 4.25” (C) 4.5”  (D) 4.37” 
320. Default tab stops are at _____ in MS word 2010. 
 (A) 0.25” (B) 0.5” (C) 0.75”  (D) 1” 
321. Text or number/bullet indent can take value b/w? 
 (A) 0” to 12” (B) -12” to 12” (C) 0” to 22”  (D) -22” to 22” 
322. The maximum value up to a list of bullet and numbering can reach in MS word 2010? 
 (A) 32765 (B) 32770 (C) 32767  (D) 32766 
323. Number and bullets alignment can be EXCEPT? 
 (A) Left (B) Justified (C) Right  (D) Center (E) none 
324. Word can insert many symbols; each symbol has specific code, the symbols in the list of symbol 

(decimal) have the code values b/w? 
 (A) 32-256 (B) 32-255 (C) 31-256  (D) 31-255 
325. Default line spacing offered by MS word is? 
 (A) 1 (B) 1.15 (C) 1.25  (D) 1.5 
326. Left indent can take value b/w? 
 (A) 0” to 12” (B) -12” to 12” (C) 0” to 22”  (D) -22” to 22” 
327. Right indent can take value b/w? 
 (A) 0” to 12” (B) -12” to 12” (C) 0” to 22”  (D) -22” to 22” 
328. Hanging indent can take value b/w? 
 (A) 0” to 12” (B) -12” to 12” (C) 0” to 22”  (D) -22” to 22” 
329. First line indent can take value b/w? 
 (A) 0” to 12” (B) -12” to 12” (C) 0” to 22”  (D) -22” to 22” 
330. By the default, left indent has value? 
 (A) 0” (B)  1” (C) 2”  (D) 0.5” 
331. By the default, Right indent has value? 
 (A) 0” (B)  1” (C) 2”  (D) 0.5” 
332. By the default, first line indent has value? 
 (A) 0” (B)  1” (C) 2”  (D) 0.5” 
333. By the default, hanging indent has value? 
 (A) 0” (B)  1” (C) 2”  (D) 0.5” 
334. By the default, paragraph spacing is already added _______ paragraph. 
 (A) Before (B) After (C) both  (D) none 
335. By the default, paragraph spacing is already added after paragraph, its value is _____ in points? 
 (A) 1 (B) 2 (C) 10  (D) 20 
336. If we add line spacing, and its unit is equal to the space of a line, then it can take value b/w? 
 (A) 1-132 (B) 0.5-132 (C) 2-132  (D) 3-132 
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337.  If we add line spacing, and its unit is points, then it can take value b/w? 
 (A) 0-1584 (B) 0.5-1584 (C) 1-1584  (D) 2-1584 
338. The line spacing option, which offers its units in points? 
 (A) Multiple (B) double (C) At least  (D) Single 
339. The line spacing option, which offers it units in points? 
 (A) Multiple (B) Exactly (C) 1.5 lines  (D) Single 
340. If we apply line spacing, in points, its default value is? 
 (A) 8 (B) 1 (C) 10  (D) 12 
341. MS word applies default line spacing of 1.15, its unit is? 
 (A) Points (B) Lines (C) Inches  (D) Centimeters 
342. Default value of spacing after the paragraph is in points? 
 (A) 0 (B) 1 (C) 10  (D) 12 
343. If we add spacing before and after paragraph, it is added in points, the value it can take is? 
 (A) 0-1584 (B) 0.5-1584 (C) 1-1584  (D) 2-1584 
344. Line spacing value offered by MS word in line spacing drop down list is in b/w in lines unit? 
 (A) 0-3 (B) 0-4 (C) 1-3  (D) 1-4 
345. Coloring option is also present in paragraph ribbon; its function is? 
 (A) Color the text of the whole paragraph 
 (B) Color the text and the background of the whole paragraph 
 (C) Color the lines and its background wholly 
 (D) Color the lines text only  (E) Color the paragraph text only  

(F) Color the paragraph background only 
346. The default color selected in coloring option present in paragraph ribbon is? 
 (A) Black (B) Red (C) White  (D) Green 
347. Gridlines can only be shown in? 
 (A) MS Excel (B) MS Word (C) both  (D) none 
348. Gridlines option is present under ______ tab. 
 (A) Home (B) Insert  (C) View  (D) Review 
349. Bullets and numbering are present in ______ ribbon. 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 
350. Gridlines are present in ______ ribbon. 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 
351. Alignment of paragraphs is present under ____ tab. 
 (A) Home (B) Insert  (C) View  (D) Review 
352.  Alignment of paragraphs is present in ribbon? 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 
353. Line spacing option is present under _____ tab. 
 (A) Home (B) Insert  (C) View  (D) Review 
354. Line spacing options is present in ribbon? 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 
355. Coloring the background of paragraph option is present under _____ tab. 
 (A) Home (B) Insert  (C) View  (D) Review 
356. Coloring the background of paragraph option is present in ribbon? 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 
357. Decrease indent and increase indent options are present under ______ tab. 
 (A) Home (B) Insert  (C) View  (D) Review 
358. Decrease indent and increase indent options are present in ribbon? 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 
359. The paragraph can be sorted by? 
 (A) Date (B) Number (C) Text  (D) all 
360. Bold option is present under _____ tab. 
 (A) Home (B) Insert  (C) View  (D) Review 
361. Bold option is present in ribbon? 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 
362. Italics option is present under ______ tab. 
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 (A) Home (B) Insert  (C) View  (D) Review 
363. Italics option is present in ribbon? 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 
364. Underline option is present under ____ tab. 
 (A) Home (B) Insert  (C) View  (D) Review 
365. Underline option is present in ribbon? 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 
366. Strikethrough option is present under ____ tab. 
 (A) Home (B) Insert  (C) View  (D) Review 
367. Strikethrough option is present in ribbon? 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 
368. Superscript option is present under ____ tab. 
 (A) Home (B) Insert  (C) View  (D) Review 
369. Superscript option in present in ribbon? 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 
370. Subscript option is present under ____ tab. 
 (A) Home (B) Insert  (C) View  (D) Review 
371. Subscript option in present in ribbon? 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 
372. Fonts size drop down list option is present under ____ tab. 
 (A) Home (B) Insert  (C) View  (D) Review 
373. Fonts size drop down list option in present in ribbon? 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 
374. Fonts drop down list option is present under ____ tab. 
 (A) Home (B) Insert  (C) View  (D) Review 
375. Fonts drop down list option in present in ribbon? 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 
376. Capitalization option is present under ____ tab. 
 (A) Home (B) Insert  (C) View  (D) Review 
377. Capitalization option in present in ribbon? 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 
378. Increase and decrease font button is present under ____ tab. 
 (A) Home (B) Insert  (C) View  (D) Review 
379. Increase and decrease font button in present in ribbon? 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 
380. The data which can be sorted by MS word sort option is? 
 (A) Text (B) Alphabets (C) Numeric  (D) all 
381. MS word considers different fields of data, when there is _____ present b/w fields. 
 (A) Comma (B) Hyphen (C) Tab  (D) all 
382. The default field separating symbol is? 
 (A) Comma (B) Hyphen (C) Tab  (D) all 
383. If you specify the other symbol for separation of fields, MS word offers a default symbol which is? 
 (A) Comma (B) Hyphen (C) Tab  (D) all 
384. If your file contains hidden text; and you have shown paragraph marks, then which symbol tells you 

that it is hidden text present here? 
  (A) A full fledge length line under text (B) Inverted commas holding down the text 
   (C) Brackets holding down the whole hidden text  (D) a dotted line under the text 

385. This mark is shown when we show the paragraph marks; specifying which? 
 (A) There is a new paragraph starting (B) there contain hidden text in that line 
 (C) There is object placed   (D) there are several words needs spelling correction 
386. Auto-correct option is very useful; when Auto-correct rules and Math Auto-correct conflicts; which 

one will be preferred? 
 (A) Math-auto correct (B) Auto-Correct (C) both are equal  (D) none 
387. In math-auto correct, you type words, which mostly referred or converted in to? 
 (A) Pictures   (B) Symbols (C) Equations  (D) Variables 
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388. When Word checks spellings, it ignores which of the following? 
 (A) Words in upper case  (B) Words containing numbers  

(C) Internet or file addresses (D) all 
389. When Word checks spellings, it flags words having correct spelling but? 
 (A) Repeated (B) Used frequently  (C) Having a lot of synonyms (D) all 
390. Auto-Recover file location of MS Word 2010 is? 
 (A) Documents folder (B) System Folder (C) Application data folder  (D) none 
391. “Save auto recover Information every” option can take maximum value of in minutes? 
 (A) 60 (B) 120 (C) 180  (D) 999 
392. “Save auto recover Information every” option can take minimum value of in minutes? 

(A) 0.25 (B) 0.5 (C) 0.75  (D) 1 
393. Default word file saving location is? 
 (A) Documents (B) Desktop (C) Compact Disc address 1  (D) Local Disc address 1 
394. Default time for saving auto recovery information is in minutes? 
 (A) 1 (B) 2 (C) 5  (D) 10 
395. How much default languages are installed to edit documents? 
 (A) 1 (B) 2 (C) 5  (D) 10 
396. Default languages to edit documents include? 
 (A) English (U.S) (B) English (U.K) (C) Spanish  (D) all 
397. If you are doing copy, paste in the same document, the default “paste special” option which is 

selected or assigned to paste or Ctrl+ V keys is? 
 (A) Keep Source formatting  (B) Keep Text Only 
 (C) Merge Formatting   (D) Use destination Styles 
398. If you are doing copy, paste in b/w documents, when style definitions are same, the default “paste 

special” option which is selected or assigned to paste or Ctrl+ V keys is? 
 (A) Keep Source formatting  (B) Keep Text only 
 (C) Merge Formatting   (D) Use destination Styles 
399. If you are doing copy, paste in b/w documents, when style definition conflict, the default “paste 

special” option which is selected or assigned to paste or Ctrl+ V keys is? 
 (A) Keep Source formatting  (B) Keep Text only 
 (C) Merge Formatting   (D) Use destination Styles 
400. If you are doing copy, paste from other programs, the default “paste special” option which is 

selected or assigned to paste or Ctrl+ V keys is? 
 (A) Keep Source formatting  (B) Keep Text only 
 (C) Merge Formatting   (D) Use destination Styles 
401. If we are inserting or pasting a picture, then it is pasted as? 
 (A) In the line of text (B) Below the text (C) above the text  (D) none 
402. The single key which can be used for pasting is? 
 (A) Print Screen (B) Insert (C) Ctrl+ V  (D) all 
403. MS word can also compress images about its quality and size and can give output image file, the unit 

of its output is? 
 (A) Spi (B) dpi (C) ppi  (D) fpi 
404. MS word can also compress images about its quality and size and can give output image file, the 

default value of its output is? 
 (A) 220 (B) 150 (C) 96  (D) 128 
405. MS word can also compress images about its quality and size and can give output image file, the 

maximum value of its output can be? 
 (A) 220 (B) 150 (C) 96  (D) all 
406. MS word can use draft font for draft and outline views, the default font for that purpose is? 
 (A) Times New Roman (B) Courier New (C) Calibri  (D) Cambria 
407. MS word can use draft font for draft and outline views, the default font size for that purpose is? 
 (A) 12 (B) 10 (C) 8  (D) 6 
408. MS word show measurements in units of by the default? 
 (A) Centimeter (B) Points (C) Inches  (D) all 
409. MS word can show measurements in units? 
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 (A) Centimeter (B) Points (C) Inches  (D) Millimeters (E) Picas (F) all 
410. Style area pane width in draft and outline views has the default value of? 
 (A) 0” (B) 5.34” (C) 1”  (D) 2” 
411. Style area pane width in draft and outline views has the maximum value of? 
 (A) 0” (B) 5.34” (C) 1”  (D) 2” 
412. Style area pane width in draft and outline views has the minimum value of? 
 (A) 0” (B) 5.34” (C) 1”  (D) 2” 
413. MS word can access to ____ number of recent items. 
 (A) 10 (B) 15 (C) 25  (D) 50 
414. Sort button is present under _____ tab. 
 (A) Home (B) Insert  (C) View  (D) Review 
415. Sort button is present in ribbon? 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 
416. Paragraph mark button is present under ______ tab. 
 (A) Home (B) Insert  (C) View  (D) Review 
417. Paragraph mark is present in ribbon? 
 (A) Font (B) Paragraph (C) Styles  (D) Editing 

418. It is the mark showing indent which is? 
 (A) First line (B) Left (C) Right  (D) Hanging 

419. It is the mark showing tab stop which is? 
 (A) Right (B) Left (C) Center  (D) all 

420. It is the mark showing tab stop which is? 
 (A) Right (B) Left (C) Center  (D) all 

421. It is the mark showing tab stop, which is? 
 (A) Right (B) Left (C) Center  (D) all 

422. It is the button assigned function which is? 
 (A) To disable rulers whether it is horizontal or vertical 
 (B) To disable tab stops whether it may any 
 (C) To disable indents whether it may any 
 (D) To disable scroll bars whether it mat horizontal or vertical 

423.  The position of this button is? 
 (A) Left to the vertical ruler and top most position 
 (B) Left to the horizontal ruler and the top most position 
 (C) Right to the horizontal ruler and top most position  

(D) Right to the Scroll bar and the top most position 

424. The position of this button is? 
 (A) Upper Right most (B) Upper left most (C) Lower Right most  (D) Lower left most 

425. Position of this button is? 
 (A) Left to the vertical ruler and top most position 
 (B) Left to the horizontal ruler and the top most position 
 (C) Right to the horizontal ruler and top most position  

(D) Right to the Scroll bar and the top most position 

426. Position of that button is? 
 (A) Left to the vertical ruler and top most position 
 (B) Left to the horizontal ruler and the top most position 
 (C) Right to the horizontal ruler and top most position  

(D) Right to the Scroll bar and the top most position 

427.  Position of this button is? 
 (A) Upper Right most (B) Upper left most (C) Lower Right most  (D) Lower left most 

428. Position of that button is? 



Prof. M. Javed Akhtar  In the name of ALLAH M S  W O R D  2 0 1 0  

P a g e  | 21 03083357385 Anwar Majid 
 

 (A) Upper Right most (B) Upper left most (C) Lower Right most  (D) Lower left most 

429. It is the button for which indentation? 
 (A) Right (B) Left (C) Hanging  (D) First line 

430. The position of this button is? 
 (A) Left to the vertical ruler and top most position 
 (B) Left to the horizontal ruler and the top most position 
 (C) Right to the horizontal ruler and top most position  

(D) Right to the Scroll bar and the top most position 

431. The position of this button is? 
 (A) Upper Right most (B) Upper left most (C) Lower Right most  (D) Lower left most 

432. It is the button of which? 
 (A) Bar tab  (B) Tab stop (C) Indentation  (D) none 

433.  The position of this button is? 
 (A) Upper Right most (B) Upper left most (C) Lower Right most  (D) Lower left most 

434.  The position of this button is? 
 (A) Left to the vertical ruler and top most position 
 (B) Left to the horizontal ruler and the top most position 
 (C) Right to the horizontal ruler and top most position  

(D) Right to the Scroll bar and the top most position 
435. Heading styles are present under ____ tab. 
 (A) Home  (B) Insert (C) View  (D) Review 
436. Heading styles are present ribbon? 
 (A) Font  (B) Paragraph (C) Styles  (D) Style 
437. By the default MS Word offers ____ numbers of heading styles. 
 (A) 1  (B) 2 (C) 3  (D) 4 
438.  It is Quad arrow, shown on dialog boxes when? 
  

(A) It is shown when we press left mouse button and drag the dialog box to move it 
 (B) It is shown when we select Move from drop down menu of title bar of window 
 (C) It is shown when we select Move from drop down menu of title bar of dialog box 

(D) Both b and c (E) all 
439. There are _____ types of rulers present in MS word 2010. 
 (A) 1  (B) 2 (C) 3  (D) 4 
440. Type of Rulers includes all EXCEPT? 
 (A) Horizontal (B) Vertical (C) Diagonal  (D) none 
441. Header and Footer are at _____ margins from up and down edges by the default. 
 (A) 0.25”  (B) 0.5” (C) 0.75”  (D) 1.0” 
442. Headers and footers are important functions; choose the statement which is false about them? 
 (A) Header and footers can be different for first page of the section 
 (B) Header and footers can be different for last page of the section 
 (C) Header and footers can be different for even and odd pages of the section   

(D) Header and footers can be same for all pages of the section 
443. Header and footer can be maximum ____ inches away from edges. 
 (A) 0” (B) 1” (C) 12”  (D) 22” 
444. Header and footer can be minimum ____ inches away from edges. 
 (A) 0” (B) 1” (C) 12”  (D) 22” 
445. The default style selected for writing in MS word 2010 is? 
 (A) Heading 1 (B) No spacing (C) Normal  (D) Heading 3 
446. If you continue to apply heading style, the maximum number of heading styles can be reached, the 

maximum number of heading styles is? 
 (A) 15 (B) 10 (C) 9  (D) 8 
447. MS word offer a number of quick writing styles; the default writing style is? 
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 (A) Elegant (B) Fancy (C) Simple  (D) Black & White 
448. There are ____ numbers of built-in paragraph spacing options offered by MS word 2010. 
 (A) 5 (B) 6 (C) 7  (D) 8 
449. Built-in Paragraph spacing includes all EXCEPT? 
 (A) Compact (B) Triple (C) Double  (D) Open (E) Relaxed 
450. Parameters of Spacing in Compact style of Paragraph spacing have the values? (Line spacing in line 

unit and paragraph spacing in points) 
 (A) Before 0, After  0, Line Spacing 1  

(B) Before 0, After  4, Line Spacing 1 
(C) Before 0, After  6, Line Spacing 1.15 
(D) Before 0, After  10, Line Spacing 1.15 

451. Parameters of Spacing in No Paragraph space style of Paragraph spacing have the values? (Line 
spacing in line unit and paragraph spacing in points) 

 (A) Before 0, After  0, Line Spacing 1  
(B) Before 0, After  4, Line Spacing 1 
(C) Before 0, After  6, Line Spacing 1.15 
(D) Before 0, After  10, Line Spacing 1.15 

452. Parameters of Spacing in Tight style of Paragraph spacing have the values? (Line spacing in line unit 
and paragraph spacing in points) 

 (A) Before 0, After  0, Line Spacing 1  
(B) Before 0, After  4, Line Spacing 1 
(C) Before 0, After  6, Line Spacing 1.15 
(D) Before 0, After  10, Line Spacing 1.15 

453. Parameters of Spacing in Open style of Paragraph spacing have the values? (Line spacing in line unit 
and paragraph spacing in points) 

 (A) Before 0, After  0, Line Spacing 1  
(B) Before 0, After  4, Line Spacing 1 
(C) Before 0, After  6, Line Spacing 1.15 
(D) Before 0, After  10, Line Spacing 1.15 

454. Parameters of Spacing in Relaxed style of Paragraph spacing have the values? (Line spacing in line 
unit and paragraph spacing in points) 

 (A) Before 0, After  0, Line Spacing 1  
(B) Before 0, After  4, Line Spacing 1 
(C) Before 0, After  8, Line Spacing 1.5 
(D) Before 0, After  6, Line Spacing 1.5 

455. Parameters of Spacing in Double style of Paragraph spacing have the values? (Line spacing in line 
unit and paragraph spacing in points) 

 (A) Before 0, After  0, Line Spacing 1  
(B) Before 0, After  4, Line Spacing 1 
(C) Before 0, After  8, Line Spacing 1.5 
(D) Before 0, After  8, Line Spacing 2 

456. There are a huge number of built in styles of Fonts in MS word 2010; the default built-in style is 
named as? 

 (A) Office (B) Office 2 (C) Office Classic  (D) Apex (E) Adjacency 
457. There are a huge number of built in color schemes in MS word 2010; the default built-in color 

scheme is named as? 
 (A) Office (B) Greyscale (C) Black & White  (D) Apex (E) Adjacency 
458. Editing Ribbon of the Home tab has _____ number of options. 
 (A) 3 (B) 5 (C) 7  (D) 9 
459. Options of editing ribbon includes all EXCEPT? 
 (A) Find (B) Replace (C) Edit  (D) Select 
460. If you want to find paragraph marks by find option, you have to write ____ in search box. 
 (A) Punctuation Marks (B) Paragraph Marks (C) $p  (D) ^P 
461. If you want to find tab character by find option, you have to write ____ in search box. 
 (A) Tab character (B) Tab Mark (C) $t  (D) ^t 
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462. If you want to find any character by find option, you have to write ____ in search box. 
 (A) Any character (B) any Mark (C) $?  (D) ^? 
463. If you want to find any digit or number by find option, you have to write ____ in search box. 
 (A) Any number (B) any digit (C) $#  (D) ^# 
464. If you want to find any letter by find option, you have to write ____ in search box. 
 (A) Any letter (B) any alphabet (C) $$  (D) ^$ 
465. If you want to find caret character by find option, you have to write ____ in search box. 
 (A) Caret Character (B) Caret Marks (C) $^  (D) ^^ 
466. If you want to find section character by find option, you have to write ____ in search box. 
 (A) Section Character (B) Section Marks (C) $%  (D) ^% 
467. If you want to find paragraph character by find option, you have to write ____ in search box. 
 (A) Paragraph Character (B) Paragraph Marks (C) $v  (D) ^v 
468. If you want to find column break by find option, you have to write ____ in search box. 
 (A) Column break (B) column break Marks (C) $n  (D) ^n 
469. If you want to find em dash by find option, you have to write ____ in search box. 
 (A) Em dash (B) Dash Marks (C) $+  (D) ^+ 
470. If you want to find en dash by find option, you have to write ____ in search box. 
 (A) En dash (B) Dash Marks (C) $=  (D) ^= 
471. If you want to find endnote mark by find option, you have to write ____ in search box. 
 (A) Endnote (B) endnote mark (C) $e  (D) ^e 
472. If you want to find a field by find option, you have to write ____ in search box. 
 (A) A field (B) Field Mark (C) $d  (D) ^d 
473. If you want to find footnote mark by find option, you have to write ____ in search box. 
 (A) Footnote (B) Footnote mark (C) $f  (D) ^f 
474. If you want to find a graphic by find option, you have to write ____ in search box. 
 (A) Graphics (B) Picture (C) $g  (D) ^g 
475. If you want to find manual line break by find option, you have to write ____ in search box. 
 (A) Line break (B) Manual Line (C) $l  (D) ^l 
476. If you want to find manual page break by find option, you have to write ____ in search box. 
 (A) Page break (B) Manual Page (C) $m  (D) ^m 
477. If you want to find nonbreaking hyphen by find option, you have to write ____ in search box. 
 (A) Non breaking hyphen (B) Hyphen Mark (C) $~  (D) ^~ 
478. If you want to find nonbreaking space by find option, you have to write ____ in search box. 
 (A) Non breaking space (B) Space Mark (C) $s  (D) ^s 
479. If you want to find optional hyphen by find option, you have to write ____ in search box. 
 (A) Optional hyphen (B) Hyphen Mark (C) $-  (D) ^- 
480. If you want to find Section by find option, you have to write ____ in search box. 
 (A) Section Break (B) Break Mark (C) $b  (D) ^b 
481. If you want to find White space by find option, you have to write ____ in search box. 
 (A) White Space (B) Blank Space (C) $w  (D) ^w 
482. Manual tab stops can also be created; if you want to remove one or more tab stop, you can do it by? 
 (A) Select the tab stop and drag it outside the ruler to remove it smoothly 
 (B) Double click on the ruler; select the tab you want to remove and then press clear 
 (C) Go to paragraph dialog box select tabs option; then again do the clear procedure 

(D) all 
483. In full screen reading view, which of the following tab remains appeared? 
 (A) Home (B) Insert (C) Page layout  (D) View (E) none 
484. In full screen reading view, which one of the following tab does not appear? 
 (A) Home (B) Insert (C) Page layout  (D) View (E) all 
485. In full screen reading view, ______ numbers of tabs remain appeared. 
 (A) 0 (B) 1 (C) 2  (D) 4 (E) none 
486. If you are working in full screen reading view, navigation pane can be shown, its purpose is to? 
 (A) Show all the pages of your document like slides in power point, to move across smoothly
 (B) Show all the headings of your document, to move across smoothly  

(C) Show search dialog box for your document, to find smoothly   
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(D) All   
(E)  None 

487. In full screen reading view, which one of the following color option is showed? 
 (A) Text color (B) Text background color (C) Object fill  (D) Line fill (E) none 
488. In full screen reading view, which of the following option is present on the title bar or main bar? 
 (A) Open (B) Save (C) Save as  (D) Recent (E) none 
489. In mini translator, you can translate your document or selection to which language? 
 (A) Arabic (B) Spanish (C) French  (D) English (E) all 
490. You can close full screen reading view by? 
 (A) Pressing Close or cross button on the title bar 
 (B) Pressing Esc key from your key-board 
 (C) Both  (D) none 
491. Which of the following view restricts the editing or formatting totally? 
 (A) Print Layout (B) Web layout (C) Full-screen (D) Draft (E) all except d 
492. Which of the following view gives less editing or formatting options? 
 (A) Print Layout (B) Web layout (C) Full-screen (D) Draft (E) all except d 
493. the most common used view is? 
 (A) Print Layout (B) Web layout (C) Full-screen (D) Draft (E) Outline 
494. In MS word, which of the following can be minimized? 
 (A) Window (B) MS word whole (C) Tabs or ribbons (D) both a and b (E) all 
495. The shortcut key to minimize the ribbon is? 
 (A) Alt+ F1 (B) Ctrl+ F1 (C) Alt+ F3 (D) Ctrl+ F3 (E) none 
496. Minimize the ribbon button is present _______ the ribbons? 
 (A) Below (B) Above (C) Left  (D) Right (E)  none 
497. Minimize the ribbon button is present on______ corner of the screen? 
 (A) Upper Left most (B) Upper Right most (C) Lower Left most (D) Lower right most (E) none 
498. Help button is present on ______ corner of screen. 
 (A) Upper Left most (B) Upper Right most (C) Lower Left most (D) Lower right most (E) none 
499. Selection making is a difficult procedure; you can select which one by one click or shortcut key? 
 (A)  All the text present in the whole document 

(B) All the objects present in the whole document 
(C) All the text having similar formatting 
(D) All the text having no data  (E)  all 

500. MS word can show up to _____ number of pages, decreasing the zoom view? 
 (A) 5 (B) 10 (C) 15 (D) variable 
501. MS word offers ____ numbers of built-in cover pages. 
 (A) 20 (B) 19 (C) 18 (D) 17 
502. By the default MS word offer _____ pages maximum to show on the single screen? 
 (A) 1 (B) 2 (C) 4 (D) 8 
503. You can set zoom views according to your choice, the default option offered for this purpose 

includes EXCEPT? 
 (A) Fit to the width of the page (B) Fit to the height of the page 
 (C) Fit to the width of the text (D) Fit to the whole page 
504. The default number of columns selected, when you chose insert table is? 
 (A) 20 (B) 15 (C) 10 (D) 5 
505. The default number of rows selected, when you chose insert table is? 
 (A) 2 (B) 4 (C) 8 (D) 6 
506. The default table size offered by MS word, when you chose insert table is? 
 (A) 10*5 (B) 10*2 (C) 5*2 (D) 5*4 
507. If MS Word specifies a table size, which is the default respective order of parameters? (C for column 

and r for row) 
 (A) R*C (B) C*R (C) R/C (D) C/R 
508. By the default MS Word offers ____ range of column. 
 (A) 1-5 (B) 1-10 (C) 1-8 (D) 1-15 
509. By the default MS Word offers ____ range of rows. 
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 (A) 1-5 (B) 1-10 (C) 1-8 (D) 1-15 
510. By the default MS Word offers minimum size of table. 
 (A) 1*1 (B) 1/1 (C) 1*2 (D) 2*1 
511. By the default MS Word offers maximum size of table. 
 (A) 10*10 (B) 10/10 (C) 10*8 (D) 8*10 
512. MS Word can insert ______ number of columns minimum in table? 
 (A) 0 (B) 1 (C) 2 (D) 4 
513. MS Word can insert ______ number of columns maximum in table? 
 (A) 53 (B) 63 (C) 73 (D) 83 
514. MS Word can insert ______ number of rows minimum in table? 
 (A) 0 (B) 1 (C) 2 (D) 4 
515. MS Word can insert ______ number of rows maximum in table? 
 (A) 32,766 (B) 32,767 (C) 32,768 (D) 32,769 
516. The minimum size of a table that MS word can insert is? 
 (A) 1*1 (B) 1/1 (C) 1*2 (D) 2*1 
517. The maximum size of table that MS word can insert is? 
 (A) 32767*63 (B) 32767/63 (C) 63*32767 (D) 63*32768 
518. MS word offers _____ number of built-in styles for quick table. 
 (A) 10 (B) 9 (C) 8 (D) 7 
519. If your data is more than the limits of MS word table, then which option will match your need? 
 (A) You have to manage your data in MS excel rather than MS word 
  (B) You have to insert more than one table to manage the data 
 (C) You have to insert MS Excel spreadsheet into MS word document to manage it 

(D) You can manage it by adding data into charts rather than tables 
520. Is it possible to add MS excel spreadsheet into MS word document? 
 (A) Yes (B) No (C) either a or b (D) neither a nor b 
521. If you typed text already; and you want to add it to table, which action will best suits you? 
 (A) Cut the whole data and paste it in table after inserting it 
 (B) Create new document; insert table and copy data to that table one by one 
 (C) Select convert text to table option; and MS word will manage it into table 
 (D) Select convert text to MS excel spreadsheet to manage it most easily 
522. If you convert data into the table, by the default which symbol tells MS word that now the data is to 

be entered into the new column if you have to choose symbol yourself? 
 (A) Period (B) Slash (C) Hyphen  (D) all 
523. If you convert data into the table, which symbol can tell MS word that now the data is to be entered 

into the new column if you want to choose symbol on your own? 
 (A) Dot (B) dash (C) inverted commas (D) all 
524. If you convert data into the table, by the default which symbol tells MS word that now the data is to 

be entered into the new column if symbol is to be selected by MS word on its own? 
 (A) Number sign (B) comma (C) dollar sign (D) all 
525. If you have already inserted a table, what can you make insertion to it? 
 (A) Columns (B) Rows (C) Cells (D) both a and b (E) all 
526. If you selected a cell or table and press delete from keyboard what will happen? 
 (A) It will delete the contents of the cell or table 
 (B) It will delete the actual cell or table 
 (C) It will delete the actual cell or table but contents remain written  

(D) all 
527. Eraser is given for table, its function is to? 
 (A) Delete or erase the contents of table where required  

(B) Delete or erase the borders of the table where necessary 
(C) Deletes or erases the shadings and colors of table where needed  
(D) all 

528. If you drag the eraser making a box encircling the whole table, what will happen? 
 (A) All the contents of table are deleted 
 (B) All the borders of the table are erased but table remains 
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 (C) All the borders are erased and table is also vanished 
 (D) all 
529. Line weight and line width are ______ parameters of table? 
 (A) Same (B) Different (C) both may be (D) none 
530. Default line width of the table borders is ______ in points? 
 (A) 0.5 (B) 1 (C) 1.5 (D) 2 
531. MS word offers minimum _____ of width of the length of the line of the borders in points. 
 (A) 0.25 (B) 0.5 (C) 1 (D) 1.25 
532. MS word offers maximum _____ of width of the length of the line of the borders in points. 
 (A) 5 (B) 6 (C) 7 (D) 8 
533. A computer expert is claiming that the under shown picture is a table drawn by MS word 2010, will 

you accept that he is saying true?  
 (A) Yes (B) No (C) Never (D) May be yes or no 
534. MS word offers _____ number of built-in style of tables. (Not to remember MCQ, extra one) 
 (A) 100 (B) 98 (C) 96 (D) 94 
535. MS word offers different styles for rows; it offers style for ________rows EXCEPT? 
 (A) Header (B) Last (C) Total (D) Banded 
536. MS word offers different styles for columns; it offers style for ________columns EXCEPT? 
 (A) First (B) Last (C) Total (D) Banded 
537. Shading of table is important function of MS word; table can be shaded on which level? 
 (A) Whole table (B) Cell (C) Text (D) Paragraph (E) both a and b (F) all 
538. The default borders styles for table of MS word 2010 includes EXCEPT? 
 (A) None (B) Box (C) All (D) Grid (E) Custom 
539. The default borders styles of MS word for page includes all EXCEPT? 
 (A) None (B) Box (C) Shadow (D) 3-D (E) Custom 
540. The width of page border can take maximum value of in points if it is art? 
 (A) 32 (B) 31 (C) 30 (D) 29 
541.  The width of page border can take maximum value of in points if it is line? 
 (A) 6 (B) 5 (C) 4 (D) 3 
542. Selecting a table is a different selection procedure; you can select while selecting table? 

(A) Row (B) Column (C) Cell (D) Table (E) all 
543. You can delete cells of table, your selection for deletion includes EXCEPT? 
 (A) Shift cells up (B) Shift cell down (C) Shift cell left (D) Entire row 
544. You can delete cells of table, your selection for deletion includes EXCEPT? 
 (A) Rows (B) Columns (C) Cell (D) none 
545. If you click on insert above or below in layout of table tools, which of the following is added? 
 (A) Rows (B) Columns (C) Cell (D) none 
546. If you click on insert left or right in layout of table tools, which of the following is added? 
 (A) Rows (B) Columns (C) Cell (D) none 
547. If you have added a table of x column, and you want to spilt into more columns the limit of the 

column will be calculated by which formula? 
 (A) Added-want to add (B) Added-Max limit (C) Max limit- Added (D) Want to added-Added 
548. If you have added a table of x column, and you want to spilt into more columns the limit of the 

column will be calculated by which formula? 
 (A) x-max  (B) max-x  (C)  x-want to add (D)  want to add-x 
549. The default spilt value for columns as we click on spilt option is? 
 (A) 2 (B) 3 (C) 4 (D) 5 
550. The default spilt value for rows as we click on spilt option is? 
 (A) 1 (B) 2 (C) 3 (D) 4 

551. The maximum value of spilt into rows is? 

 (A) 10 (B) 12 (C) 13 (D) 14 

552. If we click on spilt table button on layout in table tools, what will happen? 
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 (A) It will divide table on the selected row 

 (B) It will divide table on selected column 

 (C) It will divide table every row 

 (D) It will divide table every column 

553. The default value of row height is in table is? 

 (A) 0.20” (B) 0.19” (C) 0.18” (D) 0.17” 

554. The parameters of width and height of table is measured in? 

 (A) Inches (B) Centimeters (C) Points (D) all can be 

555. The maximum value of row height is? 

 (A) 22” (B) 16” (C) 12” (D) 6” 

556. The maximum value of column width is? 

 (A) 22” (B) 16” (C) 12” (D) 6” 

557. The maximum width of table is? 

 (A) 22” (B) 16” (C) 12” (D) 6” 

558. Indent from left of table can be max up to? 

 (A) 10” (B) 15” (C) 16” (D) 17” 

559. Indent from left of table can be min up to? 

 (A) -10” (B) -15” (C) -16” (D) -17” 

560. The default value of indent of table from left is? 

 (A) 0” (B) 1” (C) 2” (D) 3” 

561. The alignment of the table can be EXCEPT? 

 (A) Left (B) Right (C) Justified (D) Center 

562. Text wrapping of table can be EXCEPT? 

 (A) None (B) Around (C) full (D) all 

563. AutoFit behavior of table is a critical one, Auto fit of can be EXCEPT? 

 (A) To contents (B) To window (C) Fixed row height (D) Fixed column width 

564. Default cell margin of table from left is? 

 (A) 0.10” (B) 0.09” (C) 0.08” (D) 0.07” 

565. Default cell margin of table from right is? 

 (A) 0.10” (B) 0.09” (C) 0.08” (D) 0.07” 

566. Default cell margin of table from bottom is? 

 (A) 0.03” (B) 0.02” (C) 0.01” (D) 0.00” 

567. Default cell margin of table from top is? 

 (A) 0.03” (B) 0.02” (C) 0.01” (D) 0.00” 

568. The minimum row height of table can be? 

 (A) 0.03” (B) 0.02” (C) 0.01” (D) 0.00” 

569. The minimum column width can be? 

 (A) 0.15” (B) 0.16” (C) 0.17” (D) 0.18” 

570. The maximum spacing b/w cells of table allowed is? 

 (A) 2.75” (B) 3.76” (C) 3.77” (D) 3.78” 

571. The default value of spacing when spacing is applied is? 

 (A) 0.03” (B) 0.02” (C) 0.01” (D) 0.00” 

572. There are alignments possible for text in table, their number is? 

 (A) 10 (B) 9 (C) 3 (D) 4 

573. Which one of the following is not the alignment of text in the table? 

 (A) Top left (B) Bottom left (C) Center  (D) Center right (E) none 

574. There are _____ numbers of text direction possible with the text of the table? 

 (A) 5 (B) 4 (C) 3 (D) 2 
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575. Which one of the following is not the direction of the text for table? 

 (A) Straight (B) to left (C) Hanged (Reciprocal) (D) To right 

576. Conversions can be only of fewer types; which of the following auto-conversion is not possible? 

 (A) Text to table (B) Table to text (C) both (D) none 

577. Is it possible to enter formulas of MS Excel into MS word? 

 (A) Yes (B) No (C) Never (D) all 

578. Is it possible to enter functions of MS Excel into MS word? 

 (A) Yes (B) No (C) Never (D) all 

579. Is it possible to enter string functions of MS Excel into MS word? 

 (A) Yes (B) No (C) Never (D) all 

580. Formulas, Functions of MS Excel can be inserted in MS word when only? 

 (A) You are working in the table of MS word  

(B) You are working in the spreadsheet inserted in MS Word  

(C) Both  

(D) None 

581. Table tools have _____ numbers of tabs. 

 (A) 1 (B) 2 (C) 3 (D) 4 

582. Tabs of table tools include EXCEPT? 

 (A) Design (B) Layout (C) Borders and shading (D) none 

583. Design tab of table tools have _____ number of ribbons. 

 (A) 1 (B) 2 (C) 3 (D) 4 

584. Ribbons of design tab of table tool includes EXCEPT? 

 (A) Table style options (B) Table style (C) Design (D) Draw Borders 

585. Borders of table are? 

 (A) Vertical (B) Horizontal (C) Diagonal (D) both a and b (E) all 

586. Layout tab of table tools have _____ number of ribbons? 

 (A) 7 (B) 6 (C) 5 (D) 4 

587. Ribbons of layout tab of table tool include EXCEPT? 

 (A) Data (B) Merge (C) Cells (D) Rows and columns 

588. Ribbons of layout tab of table tool include EXCEPT? 

 (A) Table (B) Cell size (C) Alignment (D) Borders and shading 

589. Repeat Header Rows is the option of data ribbon of layout tab, its function is to? 

 (A) When selected the header row data is copied to every new page of the same table 

 (B) When selected the header row data is copied to every new section of the same table  

(C) When selected shading of the header is changed to white if header row design is not applied 

(D) When selected shading of the header row is changed to specific color 

590. If you want to convert table to text and specify your own symbol to separate fields, the default 

symbol suggested by MS Word 2010 is? 

 (A) Period (B) Hyphen (C) Dash (D) Brackets 

591. If you want to convert table into text. The default pattern for separating field is by? 

 (A) Paragraph Mark  (B) Tab (C) Comma (D) Hyphen 

592. If you want to convert table into text, which of the following can separate fields EXCEPT? 

 (A) Comma   (B) Tab (C) Spacing (D) Paragraph Mark 

593. Formula option is appeared in _____ tab of tools of table. 

 (A) Design (B) Layout (C) Data (D) none 

594. Formula option is appeared in ______ ribbon in MS Word 2010. 

 (A) Data (B) Layout (C) Functions (D) Merge 

595. Cell margins option is appeared in _____ tab of tools of table. 
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 (A) Design (B) Layout (C) Data (D) none 

596. Cell margins option is appeared in _______ ribbon in MS word 2010. 

 (A) Alignment (B) Data (C) Cell size  (D) Rows and Columns 

597. Statistics about the document is shown when you? 

 (A) Click on statistics on the status bar of MS word 2010 

 (B) Click on Words on the status bar of MS word 2010 

  (C) Go to View tab and click word count on the proofing ribbon 

 (D) Both b and c (E) all 

598. If your file is large one, then word will take time to check it for proofing errors, which one will tell 

you that word is in procedure of that? 

 (a) Wait cursor symbol, stopping you to write or edit further 

 (b) Waiting cursor symbol on proofing book, but you can write further 

 (c) Writing symbol on proofing book and changing of pages continuously 

 (d) Changing pages continuously and ticking every page 

599. The statistics of document shows EXECPT? 

 (a) Words (b) Paragraphs (c) Spaces (d) Pages 

600. The statistics of document shows EXECPT? 

 (a) Characters with spacing (b) Characters without spacing (c) Sections (d) Lines 

601. Textboxes, footnotes and endnotes can be included in the statistics of document. Their default 

setting is? 

 (a) Inclusion (b) Exclusion (c) both (d) none 

602. Text Direction option is appeared in _____ tab of tools of table. 

 (A) Design (B) Layout (C) Data (D) none 

603. Text direction option is under _____ ribbon of tabs of table tools. 

 (A) Alignment (B) Data (C) Cell size  (D) Rows and Columns 

604. Alignment of text in cells option is under ______ tab of table tools. 

  (A) Design (B) Layout (C) Data (D) none 

605. Alignment of text in cells option is under ______ ribbon of table tools. 

 (A) Alignment (B) Data (C) Cell size  (D) Rows and Columns 

606. Row height option is under ______ tab of table tools. 

  (A) Design (B) Layout (C) Data (D) none 

607. Row height option is under ______ ribbon of table tools. 

 (A) Alignment (B) Data (C) Cell size  (D) Rows and Columns 

608. Column width option is under ______ tab of table tools. 

  (A) Design (B) Layout (C) Data (D) none 

609. Column width option is under ______ ribbon of table tools. 

 (A) Alignment (B) Data (C) Cell size  (D) Rows and Columns 

610. AutoFit option is under ______ tab of table tools. 

  (A) Design (B) Layout (C) Data (D) none 

611. AutoFit option is under ______ ribbon of table tools. 

 (A) Alignment (B) Data (C) Cell size  (D) Rows and Columns 

612. Merge Cells option is under ______ tab of table tools. 

  (A) Design (B) Layout (C) Data (D) none 

613. Merge cells option is under ______ ribbon of table tools. 

 (A) Table (B) Merge (C) Cell size  (D) Rows and Columns 

614. Spilt Cells option is under ______ tab of table tools. 

  (A) Design (B) Layout (C) Data (D) none 

615. Spilt cells option is under ______ ribbon of table tools. 
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 (A) Table (B) Merge (C) Cell size  (D) Rows and Columns 

616. Spilt Table option is under ______ tab of table tools. 

  (A) Design (B) Layout (C) Data (D) none 

617. Spilt Table option is under ______ ribbon of table tools. 

 (A) Table (B) Merge (C) Cell size  (D) Rows and Columns 

618. Insert Above option is under ______ tab of table tools. 

  (A) Design (B) Layout (C) Data (D) none 

619. Insert Above option is under ______ ribbon of table tools. 

 (A) Table (B) Merge (C) Cell size  (D) Rows and Columns 

620. Insert Below option is under ______ tab of table tools. 

  (A) Design (B) Layout (C) Data (D) none 

621. Insert Below option is under ______ ribbon of table tools. 

 (A) Table (B) Merge (C) Cell size  (D) Rows and Columns 

622. Insert Left option is under ______ tab of table tools. 

  (A) Design (B) Layout (C) Data (D) none 

623. Insert left option is under ______ ribbon of table tools. 

 (A) Table (B) Merge (C) Cell size  (D) Rows and Columns 

624. Insert right option is under ______ tab of table tools. 

  (A) Design (B) Layout (C) Data (D) none 

625. Insert right option is under ______ ribbon of table tools. 

 (A) Table (B) Merge (C) Cell size  (D) Rows and Columns 

626. Delete Table Button is under ______ tab of table tools. 

  (A) Design (B) Layout (C) Data (D) none 

627. Delete Table Button is under ______ ribbon of table tools. 

 (A) Table (B) Merge (C) Cell size  (D) Rows and Columns 

628. Select option is under ______ tab of table tools. 

  (A) Design (B) Layout (C) Data (D) none 

629. Select option is under ______ ribbon of table tools. 

 (A) Table (B) Merge (C) Cell size  (D) Rows and Columns 

630. View Gridlines option is under ______ tab of table tools. 

  (A) Design (B) Layout (C) Data (D) none 

631. View Gridlines option is under ______ ribbon of table tools. 

 (A) Table (B) Merge (C) Cell size  (D) Rows and Columns 

632. Properties option is under ______ tab of table tools. 

  (A) Design (B) Layout (C) Data (D) none 

633. Properties option is under ______ ribbon of table tools. 

 (A) Table (B) Merge (C) Cell size  (D) Rows and Columns 

634. In MS Word table; you have inserted a formula =average (A1:A5) when A1 contains 1 A2 contains 2 

and so on for others, the answer of the formula will be? 

 (A) 1 (B) 2 (C) 3 (D) 4 

635. In MS Word table formulas can only be? 

 (A) Inserted (B) Written (C) both (D) none 

636. In MS Word table; you have inserted a formula =average (A1, A2, A3, A4, A5) when A1 contains 1 A2 

contains 2 and so on for others, the answer of the formula will be? 

 (A) 1 (B) 2 (C) 3 (D) 4 

637. The number of formulas or functions of MS Excel which can be inserted in MS word table is? 

 (A) 10 (B) 20 (C) 30 (D) Almost all 

638. MS word and Excel formulas works on same principle; which is the difference b/w them? 
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 (A) Cell referencing (B) Formula writing style (C) Cell referencing method (D) Answers of formula 

639. You can edit a formula written in MS word table; by which method? 

 (A) By pressing F2 button in the formula cell  

(B) By selecting cell and press formula button in data ribbon 

(C) By selecting cell and going to formula bar and changing it 

(D) All can be used to change formula 

640.   

 

 

 It is a table of MS Word, What will be the answer of sum (left) function? 

 (A) 8 (B) 6 (C) 2 (D) not a valid function or formula 

641. For the same table, what will be the answer of sum right function? 

 (A) 12 (B) 16 (C) 60 (D) not a valid function or formula 

642. For the same condition, what will be the answer of sum above function? 

 (A) 42 (B) 18 (C) 22 (D) not a valid function or formula 

643. MS word offers _____ numbers of text wrapping styles for object and pictures? 

 (A) 10 (B) 8 (C) 7 (D) 6 

644. Text wrapping style for object and pictures includes all EXCEPT? 

 (A) Behind the text (B) In line with text (C) Top and bottom (D) Above the text 

645. Text wrapping style for objects and pictures includes all EXCEPT? 

 (A) Crossed  (B) Square (C) Tight (D) Through (E) in front of text 

646. “Lock aspect ratio” is a critical option for quality of pictures and objects; its function is to? 

 (A) Lock the coloring scheme; while user changing it; change is made by original ratio 

 (B) Lock the size of pictures; while user changing it; change is made by original ratio 

 (C) Lock the contrast of image; while user changing it; change is made by original ratio  

(D) Lock the sharpness of image; while user changing it; change is made by original ratio 

647. The original height and width of the object or picture is considered to be? 

 (A) 1% (B) 10% (C) 100% (D) 50% 

648. You can change the height and width of the image in accordance with __________? 

 (A) Absolute size (B) Relative size (C) Scaling (D) both a and b (e) all 

649. In order to resize picture; ______ number of handles surround it. 

 (A) 10 (B) 9 (C) 8 (D) 7 

650. In order to resize picture; ______ number of circle handles surrounds it. 

 (A) 5 (B) 4 (C) 3 (D) 2 

651. In order to resize picture; ______ number of square handles surrounds it. 

 (A) 5 (B) 4 (C) 3 (D) 2 

652. In order to rotate picture; ______ number of circle handles surrounds it. 

 (A) 4 (B) 3 (C) 2 (D) 1 

653. You can rotate a picture by? 

 (A) Clicking and holding down the rotation handle rotating it up to your desired location 

 (B) Clicking and then clicking your desired location up to which you want to rotate it 

 (C) Dragging the rotating handle up to your desired location up to which you want to rotate 

 (D) Both a and c (e) all 

654. In case of square wrapping style of image, the distance of text from image; left, right, top, bottom, 

can take max value up to? 

 (A) 10” (B) 12” (C) 22” (D) 20” 

655. In case of square wrapping style of image, the distance of text from image; its default value from left 

is? 

2 4 =sum(left) 3 5 

4 8 =sum(right) 6 10 

8 16 =sum(above) 12 20 
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 (A) 0” (B) 0.13” (C) 0.26” (D) 0.3” 

656. In case of square wrapping style of image, the distance of text from image; its default value from 

right is? 

 (A) 0” (B) 0.13” (C) 0.26” (D) 0.3” 

657. In case of square wrapping style of image, the distance of text from image; its default value from top 

is? 

 (A) 0” (B) 0.13” (C) 0.26” (D) 0.3” 

658. In case of square wrapping style of image, the distance of text from image; its default value from 

bottom is? 

 (A) 0” (B) 0.13” (C) 0.26” (D) 0.3” 

659. In case of square wrapping style of image, the wrapping of text can be done form? 

 (A) Right only (B) Left only (C) Both (D) Largest only (e) all 

660. In case of square wrapping style of image, the wrapping of text can be done form _____ sides at a 

time. 

 (A) One (B) two (C) three (D) four 

661. The default size of the image inserted in MS word is? 

 (A) 10” x 12“ (B) 12” x 10”  

(C) Word changes it to image by image (D) it is according the original size of image 

662. The position of the caption of the image can be _______ the image? 

 (A) Below (B) Above (C) Left (D) Right (e) both a and b (f) both c and d (g) all 

663. The default wrapping style of the image is? 

 (A) Behind the text (B) In line with text (C) Top and bottom (D) in front of text 

664. The caption of the image is ______ written when user wants to write it. 

 (A) Auto (B) Manually (C) both (D) none 

665. The default numbering style of the caption is? 

 (A) A, B, C (B) I, II, III (C) 1, 2, 3 (D) a, b, c (e)  i, ii, iii 

666. The default numbering style of bullets and numbering is? 

 (A) A, B, C (B) I, II, III (C) 1, 2, 3 (D) a, b, c (e)  i, ii, iii 

667. The default separator use to separate chapter and image number in image caption is? 

 (A) En-dash  (B) Em-dash (C) Hyphen  (D) Period 

668. The separators which are used to separate image number and chapter in image caption includes all 

EXCEPT?  

 (A)  En-dash (B) Em-dash (C)  Hyphen (D) Period (e)  Semi Colon 

669. The chapter number in image caption is? 

 (A) Optional (B) Compulsory (C) both  (D) none 

670. Hyperlink is a type of link; it can be only applied to? 

 (A) Text  (B) Pictures  (C) Graphics (D) all 

671. is it possible to group different things; for this purpose the objects should be? 

 (A) Pictures  (B) Videos  (C) Shapes  (D) all 

672. Resizing a picture can be a difficult task; it can be done easily by? 

 (A) Select the picture and change the size as you change the font in the font dialog box 

(B) Select the picture and resize it through handles to appropriate size as by the demand  

(C) Select the picture; got to resize option in edit menu; chose size to resize   

(D) All the procedures are true 

673. Suppose you have added a wrong picture and resized it; and now you want to insert the desired 

image on that place in same size; which method suits you? 

 (A) Delete the picture; add the desired one; resize it about your desired size 

 (B) Cut the picture and insert the new one on that place and resize it 



Prof. M. Javed Akhtar  In the name of ALLAH M S  W O R D  2 0 1 0  

P a g e  | 33 03083357385 Anwar Majid 
 

(C) Select the picture; chose change picture from edit menu and insert the desired image 

resized already by Computer 

 (D) Select change the picture from picture tools and change the picture and resize it 

674. “Save as” is option present in edit menu of pictures that option can be used for? 

 (A) It can be used to change the file name and extension of the image also 

 (B) It can be only used to change the file name 

 (C) It can be used only to change the file extension 

 (D) It can be used to change the file location 

 (E) all 

675. “Edit points” is a useful option for AutoShapes of MS word; it can be used for? 

 (A) To edit the picture as a whole; each point of picture can be edited 

 (B) To edit the picture by dis-shaping it; by the resizing handles 

 (C) To edit the picture to change its colors and contrast to manage it as a whole 

 (D) All editing can be possible 

676.  

 

 

 A computer expert asked you to identify the given image by these four options; can you identify it? 

 

 (A) It is a picture created by MS paint 

 (B) It is an artwork created by hand and scanned 

 (C) It is an AutoShape of MS word   

(D) All can be 

677. If we consider the image shown above as AutoShape, can text be added to that? 

 (A) Yes  (B) No (C) Never  (D) can’t be predicated 

678. MS word clip arts includes all EXCEPT? 

 (A) Illustrations (B) Images (C) Videos  (D) Audios (e) none 

679. Which of the following can be edited by MS word? 

 (A) Inserted image (B) Clipart illustration (C) Clipart image (D) Clipart video 

680. If we press right click on any object or empty place on page in MS word 2010, a menu appeared, the 

name of that menu is? 

 (A) Edit (B) Right (C) Tools (D) none 

681. Edit menu of images can be drawn by clicking _____ click on them? 

 (A) Left (B) Right (C) Double (D) none 

682. If you want to add more steps in a cyclic process of science subject explained by MS word SmartArt, 

you can do it by? 

 (A) Go to tools of smart art and chose change layout 

 (B) Go to tools of smart art and chose add shape in shapes ribbon 

 (C) Go to edit menu and chose add shape 

 (D) Go to design menu and chose add shape 

683. The maximum level of promotion and demotion for a shape of MS word SmartArt is? 

 (A) One (B) two (C) three (D) as much as in shape 

684. The maximum height and width which can be possible for MS word SmartArt is? 

 (A) 22” (B) 12” (C) 10” (D) 6” 

685. Charts data range and the legend of the chart have a data range given by the user; choose the 

statement which best fit to the appropriateness of changing values on both axes? 

 (A) Data can be changed by changing the values in MS excel data range 

 (B) Data can be changed by changing the values in the chart itself 
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 (C) Data can be changed by changing the values in MS word table of data range 

 (D) All are appropriate methods of data change 

686. Screen clipping is a useful procedure; chose the statement which is wrong about it? 

 (A) You can clip the screen of the desktop if no window is said to be active 

 (B) You can clip the screen of the window to which you are posting the screen clip 

 (C) You can clip the screen of the window which is active at 2nd last in LIFO order  

(D) All are the correct statements 

687. “Insert pictures, clipart, shapes etc.” are the options present under following tab? 

 (A) Home (B) View (C) Insert (D) Re-view 

688. “Insert pictures, clipart, shapes etc.” are the options in the following ribbon? 

 (A) Pages (B) Illustrations (C) Images and shapes (D) Re-view 

689. Hyperlink is a link to which of the following? 

 (A) Website (B) E-mail (C) Picture (D) Program (e) all 

690. As we write the web address, it is converted into hyperlink by which of the following? 

 (A) AutoCorrect (B) Auto check (C) AutoFormat (D) Auto-Hyperlink 

691. As we write web address, it is converted into hyperlink, the color which indicates that it is hyperlink 

is? 

 (A) Blue (B) Red (C) Yellow (D) Pink 

692. The hyperlinks in MS word can be followed by pressing _____ key with click. 

 (A) Alt (B) Tab (C) Enter (D) Ctrl 

693. You can insert or write screen tip for every hyperlink, but it can be only shown in IE ____ or later? 

 (A) 3.5 (B) 3.8 (C) 4 (D) 4.1 

694. As you click on hyperlink option, insert hyperlink dialog box is appeared, which offers link to which of 

the following? 

 (A) Existing file (B) Existing webpage (C) Create new document (D) Both a and b (e) all 

695. Bookmark is a useful option whenever you are viewing something; the MS word offers bookmarks of 

the following? 

 (A) Web address (B) E-mail (C) Program (D) Documents 

696. Cross-reference can be inserted as? 

 (A) Hyperlink (B) Bookmark (C) Web-link (D) List 

697. The default header & footer space from top or bottom is? 

 (A) 0.1” (B) 0.3” (C) 0.5” (D) 0.4” 

698. Which of the following can be added to MS word header or footer? 

 (A) Page number (B) Images (C) Clipart (D) all 

699. If you add date or time in header or footer; chose the false statement? 

 (A) Computer will edit it on user’s will 

 (B) It inserts current data and time of the computer clock 

(C) The format of the data and time is as about user’s will  

(D) All statements are correct 

700. Chose the wrong statement about header and footer? 

 (A) Header and footer can be different for the first page of the document 

 (B) Header and footer can be different for the last page of the document 

 (C) Header and footer can be different for even pages 

 (D) Header and footer can be different for even pages 

 (E) Header and footer can be different for every new section  

 (F) All statements are either wrong or correct (G) All are correct EXCEPT e 

701. “Insert alignment tab” is the option of header and footer. It is about? 

 (A) Draw the line or leader showing the alignment of the line or text 
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 (B) Draw the tab to show the alignment of each line or text 

 (C) Draw the tab stop and line showing the alignment of each line or text 

 (D) None 

702. We can leave up to ______ inches space for header and footer. 

 (A) 3” (B) 6” (C) 12” (D) 22” 

703. If we press increase or decrease indent button in the paragraph ribbon, it increases or decreases the 
indent by _______ inches. 

 (A) 0.25 (B) 0.5 (C) 0.75  (D) 1 
704. MS word access to ____ number of recent items by the default? 

 (A) 25 (B) 50 (C) 15  (D) 10 

705. It is the tab stop showing which of the following tab? 

 (A) 1” (B) 2” (C) 1.5”  (D) 3” 

706. Which of the following is a word processor? 

 (A) MS word (B) Notepad (C) WordPad  (D) all 

707. MS Word 2010 is stated by an execution named? 

 (A) MSWord (B) Word2010 (C) WinWord  (D) MSWord2010 

708. Successor of MS word 2010 is MS word _______. 

 (A) 2009 (B) 2008 (C) 2007  (D) 2006 

709. If you click on insert page number option without adding header and footer, it will be? 

 (A) Added to the top and bottom of the page after and before header and footer  

(B) Added to the sides of the page showing irrespective to header and footer 

(C) Added to the header and footer after being added them automatically 

(D) Not possible to add page number at that time 

710. In AutoText of the document which one is added automatically to the document? 

 (A) Document Properties (B) File Author (C) File Location  (D) File translator 

711. Bar code creation is a unique property. Has MS word this property? 

 (A) Yes (B) No (C) may be  (D) none 

712. If bar code is created by MS word, it can create it by which of the following? 

 (A) Price of the Product (B) Expiry date (C) Zip Code  (D) all 

713. FIM is used to introduce barcode in MS word 2010, it is abbreviated for? 

 (A) Face identification mark  (B) Facing ID mark 

 (C) Full identification mark   (D) Full ID mark 

714. Text can be rotated to which of the following degree? 

 (A) 90 (B) 180 (C) 270  (D) 360 (E) both a and c (F) both b and d 

715. Create link option is of the text box can be used to only? 

 (A) Create links of the other text or word documents 

(B) Create links of the webpages which are built-up in MS word 

(C) Create links to the other empty text boxes present in the same document 

(D) Create links to the other empty text boxes present in the different documents  

(E) all 

716. If you have incorporated digital signature on a document; which statement is wrong about it? 

 (A) You can’t edit the document until the signature is removed 

 (B) If you start editing the signature will be automatically removed 

 (C) Signatures can be scanned and placed in signature as image on the document   

(D) All statements are either wrong or correct 

717. Which of the following extension can’t be added to MS word 2010? 

 (A) XLS (B) BMP (C) PDF  (D) none 
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718. If you add an extension which will not be properly understood by user, then MS word offers _____ 

to user. 

 (A) Translation (B) Encoding (C) Decoding  (D) Transcription 

719. The encodings offered by MS word 2010 is? 

 (A) Windows default (B) MS DOS (C) Korean  (D) both a and b (E) all 

720. MS word does encoding of ____ when document will not be properly understood by user.  

 (A) Images (B) Text (C) Graphics  (D) all 

 MS word offers a lot of built-n equations. Can you identify some of them? 

721.   
   √      

  
  This equation is of? 

 (A) Quadratic Formula (B) Binomial Theorem (C) Pythagorean Theorem  (D) Area of circle 

722.        This equation is of? 

 (A) Quadratic Formula (B) Binomial Theorem (C) Pythagorean Theorem  (D) Area of circle 

723. (   )  ∑ ( 
 
)      

 

   
  This equation is of? 

 (A) Quadratic Formula (B) Binomial Theorem (C) Pythagorean Theorem  (D) Area of circle 

724.          This equation is of? 

 (A) Quadratic Formula (B) Binomial Theorem (C) Pythagorean Theorem  (D) Area of circle 

725. Hyperlink option is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) Re-View 

726. Hyperlinks option is present under ______ ribbon. 

 (A) Links (B) Text (C) Symbols  (D) Pages 

727. Bookmark option is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) Re-View 

728. Bookmark option is present under ______ ribbon. 

 (A) Links (B) Text (C) Symbols  (D) Pages 

729. Cross-reference option is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) References 

730. Cross-reference option is present under ______ ribbon. 

 (A) Links (B) Text (C) Symbols  (D) Pages 

731. Header & footer option is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) Re-View 

732. Header & footer option is present under ______ ribbon. 

 (A) Links (B) Text (C) Symbols  (D) Header & footer 

733. Page number option is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) Re-View 

734. Page number option is present under ______ ribbon. 

 (A) Links (B) Text (C) Symbols  (D) Header & footer 

735. Text box option is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) References 

736. Text box option is present under ______ ribbon. 

 (A) Links (B) Text (C) Symbols  (D) Pages 

737. Quick Parts option is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) References 

738. Quick Parts option is present under ______ ribbon. 

 (A) Links (B) Text (C) Symbols  (D) Pages 

739. AutoText reference option is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) References 

740. AutoText option is present under ______ ribbon. 
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 (A) Text (B) Links (C) Symbols  (D) Pages 

741. Document Property option is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) References 

742. Document Property option is present under ______ ribbon. 

 (A) Text (B) Links (C) Symbols  (D) Pages 

743. Building Block organizer is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) References 

744. Building block organizer is present under ______ ribbon. 

 (A) Text (B) Links (C) Symbols  (D) Pages 

745. Drop Cap option is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) References 

746. Drop Cap option is present under ______ ribbon. 

 (A) Text (B) Links (C) Symbols  (D) Pages 

747. Signature Line option is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) References 

748. Signature line option is present under ______ ribbon. 

 (A) Text (B) Links (C) Symbols  (D) Pages 

749. Equation option is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) References 

750. Equation option is present under ______ ribbon. 

 (A) Text (B) Links (C) Symbols  (D) Pages 

751. Symbol is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) References 

752. Symbol is present under ______ ribbon. 

 (A) Text (B) Links (C) Symbols  (D) Pages 

753. Object option is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) References 

754. Object option is present under ______ ribbon. 

 (A) Text (B) Links (C) Symbols  (D) Pages 

755. WordArt option is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) References 

756. WordArt option is present under ______ ribbon. 

 (A) Text (B) Links (C) Symbols  (D) Pages 

757. Barcode option is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) References 

758. Barcode option is present under ______ ribbon. 

 (A) Text (B) Links (C) Symbols  (D) Pages 

759. Date and Time option is present under _____ tab. 

 (A) Home (B) Insert (C) View  (D) References 

760. Date and time is present under ______ ribbon. 

 (A) Text (B) Links (C) Symbols  (D) Pages 
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Completion Part 1st 

Part 1st of MS word 2010 is completed here. It contains total of 1000 MCQs. 

 These MCQs covers MS word topics as under 

10. Appearance 

11. Views 

12. File tab or backstage view 

13. Home tab 

14. Insert Tab 

15. Table tools (Design and layout tab) 

16. Status bar 

17. Quick access toolbar 

18. Shortcut keys and procedures (General) 

19. Privacy and Protection 

 Part 2
nd

 will encircle the topics as under 

1. Remaining Tabs (5 in number) 

2. Shortcut keys and procedure (Overall + General) 

3. Help 

4. Quick moving through the document 

5. Editing overall view 

6. Terminologies of MS word 2010 

7. Mailing and sharing of MS word 2010 documents 

8. Book (Study Text) contents (3 chapters) overall through review  
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Searched MCQs (Internet) 
1. Times New Roman, Comic Sans and Calibri are called_______. 
 (A) Fonts (B) variations (C) font sizes (D) all 
2. You insert a clip art and it is too big.  To resize it you would _____. 
 (A)  Change it the same way you change the font size 
 (B) Click on the clip art to show the handles and drag a handle to resize it 
 (C) Click the insert tab and choose resize 
3. What would you do to highlight a word?  You position the cursor next to the word and then _____. 
 (A) Drag the mouse while holding the left mouse button 
 (B) Roll mouse around (C) Click the mouse three times  
4. Another name for the cursor is the ____. 
 (A) Clicker  (B) blinker (C) Insertion point  (D) all 
5. What happens in a document when the cut command is used? 

(A) Only half the screen is seen. (B)  The application stops running.  
(C)  Selected text or graphics are removed (D) all 

6.   Which one is not a tab in Microsoft Word 2010?  
(A) File  (B)  Insert  (C)  Home  (D)  Design  

7.   Which one of the following is not in the drop-down menu when you click the File tab in Microsoft 
Word 2010?  
(A)  Save as (B)  Open  (C)  New  (D)  Backup  

8.   What tab do you go to for the spelling and grammar check?  
(A)  Home  (B)  Review  (C)  Insert  (D)  File  

9.   Which tab would you choose to change the font size of a word from 12 points to 18 points?  
(A)  File  (B)  Home  (C)  Insert  (D)  Page Layout  

10.   To save a document for the first time you would choose _________,  
(A)  Save  (B)  Save As  (C)  Neither A nor B  (D) either a or b 

11.   The title of Madison's report is 28 points.  This is the title's ____________.  
(A)  Format   (B)  Font Size  (C)  Font Style  

12.   Which tab in Microsoft Word 2010 would you select to insert a shape in to a document?  
(A)  Insert  (B)  Review  (C)  View  (D)  File  

13.   If you want to add a table or a radial diagram to your document, which tab would you choose?  
(A)  File  (B)  Home  (C)  Insert  (D)  Save  

14.   Is it possible to add column to a table that you have already created & entered information into? 
(A) Yes (B) No (C) either a or b (D) neither a nor b  

15.   You have created a table and you want to add 3 more rows to it.  To add the new rows to the table, 
you would.....  
(A)  Delete the table and start over   (B)  Left click and choose insert rows  
(C)  Right click and choose insert rows  (D)  choose the Insert tab and click on ADD  

16.   To remove a portion of text from a document, you can ___________.  
(A)  Cut it  (B)  Paste it  (C)  Undo it  (D)  Redo it  

17.   You can take a selection that you have cut or copied from the clipboard and _____________ it into a 
document.  
(A)  Cut  (B)  Paste  (C)  Copy  (D)  Undo  

18.   Different lettering designs which can be used to add variety to documents are called 
__________________.  
(A)  Symbols  (B)  Bullets  (C)  Fonts  (D)  Hyperlinks  

19.   The feature that will reverse your action should you make a mistake is called __________.  
(A)  Undo  (B)  Spell Check  (C)  Paste  (D)  Insert  

20.   This command creates a duplicate of a selection and saves it to the clipboard.  
(A)  Cut  (B)  Paste  (C)  Copy  (D)  Print  

21.   When your text is lined up on your right margin, you could say that it is _______________.  
(A)  Poetry  (B)  Right Aligned  (C)  Centered  (D)  Horizontal  

22.   Font size is measured in __________. 
(A)  Centimeters  (B)  Bytes  (C)  Points  (D)  Inches  
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23.   A table is a grid into which data can be entered.  It is made up of ___________.  
(A)  Rows  (B)  columns  (C) both a & b (D) none 

24.   Which feature do you use to create a newspaper like document? 
  (A)     Tab stops  (B)     Columns  (C)     Tables (D)   Bullets & numbering  
25.   What do you call ‘a collection of character and paragraph formatting commands’? 
  (A)     A boilerplate (B)   the defaults  (C)     a style (D)   a template  
26.  Which would you choose to list Synonyms & Antonyms of a selected word? 
  (A) Review, Spelling & Grammar   (B) Review, Language   

(C)  Review, Research  (D)  Review, Thesaurus 
27. Which key is used to increase left indent? 
  (A)     F10   (B)     Ctrl+ M  (C)     Alt+ I    (D)     Ctrl+ I  
28   Which language does MS-Word use to create Macros? 
  (A)     FoxPro   (B)     Visual C++  (C)     Visual Basic   (D)     Access  
29. To undo the last work, press ….. 
  (A)     Ctrl+ Y   (B)     Ctrl+ W   (C)     Ctrl+ U  (D)     Ctrl+ Z  
30. Which key is used to select all the text in the document? 
  (A)     Ctrl+ F   (B)     Ctrl+ T  (C)     Ctrl+ N  (D)     Ctrl+ A 
31. Which would you choose to display the statistics about a document? 
  (A)     Review, statistics  (B)     Review, statistics    

(C)     Review, word count   (D)     Review, spelling and grammar  
32.   In MS Word, Ctrl+ S is for ….. 
  (A)     Spelling Check  (B)     Scenarios   (C)     Size  (D)     Save  
33.   Single spacing in MS-WORD document causes ____ point line spacing? 
  (A)     12   (B)     16  (C)     10  (D)  8 
34. You wished to justify text over the height of paper, which option wills you choose?  

(A)  Paragraph from Format menu (B)  Page Setup from File menu 
(C) From formatting toolbar (D)  from formatting toolbar 

35.  Which of the following is not of the merge process? 
(A)  Format a main document (B)  Sort the data source records 
(C)  Edit a data source  (D)  Edit a data source 

36. Which of the following position is not available for fonts on MS Word? 
(A)  Normal (B)  Raised (C)  Lowered (D)  Centered 

37.  What is the maximum scale percentage available in Scale drop down box? 
(A)  500 (B)  100 (C) 200 (D)  90 

38. Bold, Italic, Regular are known as? 
(A)  Font styles (B)  font effects (C)  font effects (D)  text effects 

39.  Uppercase on Change Case dialog box and All Caps on Fonts dialog box both converts selected text 
into Capital Letters. What’s the difference between the two? 
(A)  Both are same. They are only two different ways of capitalize text. 
(B) It is faster to convert from Change Case than from Font dialog box 
(C) Change Case makes conversion permanent but All Caps on Font can always be reverted 
(D) All Caps on Font dialog box makes the change permanent where Change Case can be always 
reverted 

40. If you need to hide some paragraphs, how can you do it? 
(A) From Paragraph dialog box (B) From Options Dialog box 
(C) From Font dialog box  (D) none of above 

41. Which of the following is the latest version of MS Word? 
(A) Word 2000 (B) Word 2010  (C) Word 2007 (D) Word 2011 

42. Changing the appearance of a document is called? 
(A) Proofing (B) Editing (C) Formatting (D) All of above 

43. In a document what is the maximum number of columns that can be inserted in MS Word Table? 
(A) 35 (B) 63 (C) 15 (D) 65 

44.   The default view in Word is _________________  
(A)  Print Layout View (B) Headline View  (C)  Web Layout View (D) Outline View  
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45.   To enter a blank line into a document, press the _________________key without typing any text on 
the line.  
(A)  CTRL  (B)  ALT  (C)  ENTER  (D)  ESC  

46.   The paragraph mark is the mark that indicates where the _________ was pressed.  
(A)  TAB key  (B)  SPACEBAR  (C)  ENTER key  (D)  SHIFT key  

47.   Press the ENTER key in all of the following circumstances EXCEPT__________.  
(A)  To insert a blank line into a document  
(B)  When the insertion point reaches the right margin  
(C)  To begin a new paragraph  
(D)  In response to prompts in Word dialog boxes  

48.   When word flags a possible spelling or grammar error, it also changes the Spelling and Grammar 
Check icon to a _________  
(A)  Green X  (B)  green check mark  (C)  red X  (D)  red check mark  

49.   If a flagged word is spelled correctly, right-click it and then click _______ on the shortcut menu to 
instruct Word not to flag future occurrences of the same word in this document.  
(A)  Not a Mistake  (B)  Correct Spelling  (C)  Do Not Correct  (D) Ignore All  

50.   To move left one word with the keyboard, press the ________ key(s). 
(A) HOME  (B) CTRL+LEFT ARROW  (C) ALT+CTRL+LEFT ARROW (D) ALT+LEFT ARROW  

51.   To move to the beginning of a line with the keyboard, press the _______ key(s).  
(A)  LEFT ARROW  (B)  CTRL+HOME  (C)  HOME  (D)  PAGE UP  

52.   To move to the end of the document, press the __________ key(s).  
(A)  DOWN ARROW  (B)  END  (C)  CTRL+DOWN ARROW  (D)  CTRL+END  

53.   To move to the right one word, press the ___ key(s).  
(A)  ALT+RIGHT ARROW  (B)  F1  (C)  CTRL+RIGHT ARROW  (D) CTRL+END  

54.   To move up one paragraph, press the _____ key(s).  
(A)  F1  (B)  ALT+UP ARROW  (C)  UP ARROW  (D) CTRL+UP ARROW  

55.   To move down one paragraph, press the _____ key(s).  
(A)  ALT+DOWN ARROW  (B)  CTRL+DOWN ARROW  (C) DOWN ARROW (D) F1  

56.   To move to the bottom of a document window, press the _____ key(s).  
(A) ALT+CTRL+PAGE DOWN (B)  CTRL+PAGE DOWN (C) ALT+PAGE DOWN (D)PAGE DOWN  

57.   To move to the top of a document window, press the _____key(s).  
(A) CTRL+PAGE UP (B) ALT+CTRL+PAGE UP (C)  PAGE UP (D)  ALT+PAGE UP  

58.   When you use the keyboard to scroll to a different position in the document, the ______ 
automatically moves when you press the desired keys.  
(A)  Roster  (B)  insertion point (C)  alt tag (D)  smart tag  

59.   Word includes a variety of document ____ to assist you with coordinating these visual elements in a 
document.  
(A)  Layouts  (B)  formats  (C) themes  (D)  graphs  

60.   ________ formatting is the process of changing the way letters, numbers, punctuation marks, and 
symbols appear on the screen and in print.  
(A)  Document  (B)  Character  (C)  Paragraph (D)  Object  

61.   The _____ or typeface, defines the appearance and shape of letters, numbers, and special 
characters.  
(A)  Font  (B)  font size  (C)  point  (D)  paragraph formatting  

62.   On most computers the default font size in Word is _____.  
(A)  8  (B)  11  (C)  14  (D)  16  

63.   A (n) ____ paragraph is a paragraph that begins with a dot or other symbol.  
(A)  Headline  (B)  centered  (C)  bulleted  (D)  indexed  

64.   The file type _____ is a Word 2010 document.  
(A)  .doc  (B)  .DOCX  (C)  .dot  (D)  .DOCT  

65.   To select nonadjacent items, select the first item as usual, press and hold down the ____ key, and 
then while holding down the key, select additional items.  
(A)  HOME  (B)  F1  (C)  CTRL  (D)  ALT  

66.   Which of the following colors suggests neutrality?  
(A)  Green  (B)  brown  (C)  red  (D)  gray  
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67.   With more than ____ predefined color schemes, Word provides a simple way to select colors that 
work well together.  
(A)  15  (B)  20  (C)  30  (D)  40  

68.   You can select characters by using the ____ key(s).  
(A) SHIFT+RIGHT ARROW  (B) CTRL+A  (C)  SHIFT+END  (D) SHIFT+UP ARROW  

69.   You can select a document by using the ___________ key(s).  
(A) SHIFT+HOME (B) CTRL+A (C)  SHIFT+END (D) CTRL+SHIFT+END  

70.   You can select a paragraph by using the __________ key(s).  
(A) CTRL+END  (B)  SHIFT+HOME  (C) CTRL+SHIFT+DOWN ARROW (D) CTRL+SHIFT+END  

71.   You can select multiple paragraphs by using the ______ key(s) repeatedly.  
(A) CTRL+END (B) CTRL+A (C) SHIFT+HOME (D) CTRL+SHIFT+DOWN ARROW  

72.   You can select a word by using the _________ key(s).  
(A) CTRL+SHIFT+LEFT ARROW (B) CTRL+A (C) SHIFT+RIGHT ARROW (D) CTRL+W  

73.   You can select multiple words by using the __________ key(s).  
(A) CTRL+A (B) CTRL+SHIFT+RIGHT ARROW (C) SHIFT+RIGHT ARROW (D) CTRL+SHIFT+END  

74.   The small squares and circles around a selected graphic, as shown in the accompanying figure, are 
called ______ handles  
(A) Sizing  (B) shape  (C) base  (D)  dimension  

75.   To see the height and width of the currently graphic, as shown in the accompanying figure, look in 
the __________ group on the Picture Tools Format tab.  
(A)  Measurements   (B)  Options  (C)  Size  (D)  Dimensions  

76.   To center a page's contents vertically between the top and bottom margins, click the Page Setup 
Dialog Box Launcher, click the ______ tab, click the vertical alignment box arrow, click Center in the 
list, and then click OK button.  
(A)  Layout  (B)  Alignment  (C)  Position  (D)  Format  

77.   ____________ is types of changes that occur when text has been omitted from a document and 
must be inserted later.  
(A)  Additions  (B)  Deletions  (C)  Modifications  (D)  All of the above  

78.   To delete an incorrect character in a document, simply click next to the incorrect character and then 
press the ________ key(s) to erase to the left of the insertion point.  
(A)  CTRL+HOME  (B)  DELETE   (C)  BACKSPACE  (D)  END  

79.   To delete an incorrect character in a document, simply click next to the incorrect character and then 
press the _____ key(s) to erase to the right of the insertion point.  
(A) CTRL+HOME (B) DELETE (C) BACKSPACE (D)  END  

80.   __________ is words or phrases that describe a document.  
(A) Meta keys  (B)  Enhanced Screen Tips  (C)  Anchors  (D) Keywords  

81.   ______ is another term for document properties.  
(A)  Metadata  (B)  Key terms  (C)  Enhanced Text  (D)  Indices  

82.   To close the _______ view, click File on the Ribbon or click the preview of the document in the info 
gallery to return to the document window.  
(A)  Outline   (B)  Backstage  (C)  Web Layout  (D)  Both a and b  

83.   In Word, you can create electronic image files through the _____ tab in the backstage view.  
(A)  PDF  (B)  XPS  (C)  Print  (D)  Both a and b 

84. The paragraph mark (¶) is a formatting mark which resembles 
(A) Shift key was pressed  (B)  Enter key was pressed  
(C) Tab key was pressed  (D)  Caps lock key was pressed  

85. Character spacing option can be found in the 
(A)  Auto text dialog box   (B)  Font dialog box  
(C) Autocorrect dialog box   (D)  none of the above  

86. The autocorrect tool? 
(A) Check for synonyms and antonyms and replaces words automatically  
(B) Corrects the words by the time of typing  
(C) Checks the grammar in the document  (D)  All of the above  

87. What is the smallest and largest font size available in font size dropdown menu in Font Group of 
Home Tab? 
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(A) 10 and 400  (B)  8 and 144 (C) 8 and 72  (D)  11 and 72  
88. To save an already saved document to a different location, we can? 

(A) Press CTRL + S  (B) Click on office button and click save  
(C) Press F12  (D) All of the above 

89. Where can you show or hide the rulers from? 
(A) Show group of view tab   (B)  Views group of view tab  
(C) Illustrations group of insert tab  (D)  none of the above  

90. An overtype mode means? 
(A) Automatically replacing the characters on the right side of the cursor while typing  
(B) Automatically replacing the characters on the left side of the cursor while typing  
(C) An attempt to type more characters than the character limit  
(D) Typing over the already typed text 

91. What is the shortcut key to insert Hyperlink? 
(A) CTRL + H  (B)  CTRL + K  (C)  CTRL + J  (D) CTRL + Shift + H 

92. Which method of creating TOCs is the easiest to work with when you’re outlining a document? 
(A) Outline levels.  (B)  Heading styles.  (C)  Custom styles (D) All  

93. Format Painter is used? 
(A) To copy the format of a text and apply the copied format to the text selected  
(B) To paint a formatted picture  (C) To makes the document painted (D) none  

94. How to insert Drop Cap in the text? 
(A) Insert tab >> Illustration Group >> Drop Cap (B) Insert tab >> Text Group >> Drop Cap  
(C) Insert tab >> Header & Footer Group >> Drop Cap  
(D) Design tab >> Document Formatting Group >> Drop Cap  

95. What is a multilevel list? 
(A) A list with more than one items in it (B) A list with both numbers and bullets in it.  
(C) A document with more than one list in it  
(D) A list with sub lists under individual items in the main list.  

96. What is the default font in Microsoft word 2010? 
(A)  Cambria  (B)  Calibri   (C)  Times New Roman  (D)  None  

97. How many buttons are there in quick access toolbar by default? 
(A) 3  (B)   4  (C)  5  (D)  It may vary.  

98. Macros will be in ……………. tab of the MS word ribbon. 
(A) Design  (B) Insert (C) View  (D) Review  

99. MS-Word is an example of? 
(A) Application Software  (B) System Software  (C) Operating System (D) Scanner  

100. What should you type to automatically create a bulleted list that uses a black dot as the bullet 
design? 
(A) 1. And a space  (B) @ and a space  (C)  a. and a space (D) * and a space  

101. What is the maximum file size word can open? 
(A) 192 MB  (B)  256 MB  (C)  512 MB  (D)  1024 MB 

102. Which of the following position is not available for fonts on MS Word? 
(A) Raised  (B) Lowered  (C) Normal   (D) Centered 

103.   What is the maximum scale percentage available in Scale drop down box? 
(A) 300 (B) 200 (C) 100 (D) 50 

104.   Bold, Italic, Regular are known as? 
(A) Text Effects (B) font effects (C) font styles  (D) word art  

105.   Which of the following is the latest version of MS Word? 
(A) Word 2000 (B) Word 2007 (C) Word 2010  (D) Word 2011 

106.   Changing the appearance of a document is called 
(A) Editing  (B) Proofing  (C) Formatting  (D) All of above 

107.   In a document what is the maximum number of columns that can be inserted in MS Word Table? 
(A) 31 (B) 32 (C) 63 (D) 64 

108.   A screen element of MS Word that is usually located below the title bar that provides categorized 
options is? 

 (A) Status bar  (B) Menu bar (C) Tool bar (D) All of the above 
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109.   Which combination of keys used as a shortcut for go to a page? 
 (A) Alt + G  (B) Ctrl + G  (C)  Ctrl + F  (D) All Of Above 
110.   By which shortcut browse a document / browse panel will show up? 

(A) Ctrl + B  (B) Alt + B  (C) Alt + Ctrl + Home (D) Alt + Home 
111.   Shortcut to undo an action is _______? 

(A) Ctrl + a  (B) Ctrl + Z  (C) Ctrl + Esc (D) Ctrl + U 
112.  Which of the following is not valid version of MS Office?  

(A)  Office XP (B)  Office Vista (C) Office 2007 (D) none of above 
113.  You cannot close MS Word application by? 
  (A) Choosing File menu then Exit submenu (B) Press Alt+F4  

(C) Click X button on title bar  (D) From File menu choose Close submenu 
114.  The key F12 opens a? 
  (A)  “Save As” dialog box (B) Open dialog box (C) Save dialog box (D) Close dialog box 
115.  What is the short cut key to open the Open dialog box? 
  (A)  F12 (B)  Shift F12 (C)  Alt + F12 (D)  Ctrl + F12 
116.  A feature of MS Word that saves the document automatically after certain interval is available on? 
  (A) Save tab on Options dialog box (B)  Save As dialog box 

(C)  Both of above   (D) none of above 
117.  Where can you find the horizontal split bar on MS Word screen? 
  (A) On the left of horizontal scroll bar (B) On the right of horizontal scroll bar 

(C) On the top of vertical scroll bar  (D) on the bottom of vertical scroll bar 
118.  Which of the following is not available on the Ruler of MS Word screen? 
  (A) Tab stop box (B) Left Indent (C) Right Indent (D) Center Indent 
119. Which file starts MS Word? 
  (A) Winword.exe (B)  Word.exe (C) Msword.exe (D)  Word2010.exe 
120.  How many ways you can save a document? 
  (A) 3 (B)  4 (C)  5 (D)  6 
121.  If you want to keep track of different editions of a document which features will you use? 
  (A) Editions  (B)  Versions (C)  Track Change (D)  All of above 
122.  Background color or effects applied on a document is not visible in? 
  (A) Web layout view (B) Print Layout view (C)  Reading View  (D) Print Preview 
123.  What is a portion of a document in which you set certain page formatting options? 
  (A) Page  (B) Document (C)  Section  (D)  Page Setup 
124.  Borders can be applied to? 
  (A) Cells  (B) Paragraph (C) Text  (D)  All of above 
125.  Which of the following is not a type of page margin? 
  (A)  Left  (B)  Right  (C)  Center  (D) Top 
126.  What is the default left margin in Word 2010 document? 
  (A) 1a  (B) 1.25a  (C)  1.5a  (D) 2a 
127.  What is gutter margin? 
  (A) Margin that is added to the left margin when printing 

(B) Margin that is added to right margin when printing 
(C) Margin that is added to the binding side of page when printing 
(D) Margin that is added to the outside of the page when printing 

128.  Portrait and Landscape are? 
  (A) Page Orientation (B) Paper Size (C) Page Layout (D) All of above 
129.  If you need to change the typeface of a document, which menu will you choose? 
  (A)  Edit  (B) View  (C) Format  (D)  Tools 
130.  Which of the following is not a font style? 
  (A)  Bold  (B)  Italics  (C) Regular  (D)  Superscript 
131.  Pressing F8 key for three times selects? 
  (A) A word  (B) A sentence (C)  A paragraph (D) Entire document 
132.  What happens if you press Ctrl + Shift + F8? 
  (A) It activates extended selection (B)  It activates the rectangular selection 

(C) It selects the paragraph on which the insertion line is (D)  none of above 
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133.  How can you disable extended selection mode? 
  (A) Press F8 again to disable (B) Press Del to disable 

(C) Press Esc to disable  (D) Press Enter to disable 
 134.  What does EXT indicator on status bar of MS Word indicate? 
  (A)  It indicates whether the external text is pasted on document or not 

(B)  It indicates whether extended add-ons are installed on MS Word or not 
(C)  It indicates whether Extended Selection mode is turned on or off (D) none   

135.  What is the maximum number of lines you can set for a drop cap? 
  (A) 3 (B)  10 (C)  15 (D)  20 
136.  What is the default number of lines to drop for drop cap? 
  (A) 3 (B) 10 (C) 15 (D)  20 
137.  What is the shortcut key you can press to create a copyright symbol? 
  (A) Alt+ Ctrl+ C (B) Alt + C (C)  Ctrl + C  (D)  Ctrl + Shift + C 
138.  How many columns can you insert in a word document in maximum? 
  (A)  35  (B)  45 (C)  55  (D)  65 
139. What is the smallest and largest font size available in Font Size tool on formatting toolbar? 

(A) 8 and 72 (B)  8 and 64 (C) 12 and 72 (D)  none 
140.  What is the maximum font size you can apply for any character? 

(A) 163 (B) 1638 (C) 16038 (D) none 
141.  Which of the following is graphics solution for Word Processors? 
  (A) Clipart (B) WordArt (C)  Drop Cap (D) All of above 
142.  The keystrokes “Ctrl + I” is used to? 

(A) Increase font size (B) Inserts a line break  
(C) Indicate the text should be bold (D)  Applies italic format to selected text 

143.  A character that is raised and smaller above the baseline is known as 
  (A)  Outlined (B)  Raised (C) Superscript (D) Subscript 
144.  What is the purpose of inserting header and footer in document? 
  (A) To enhance the overall appearance of the document 

(B) To mark the starting and ending of page 
(C) To make large document more readable 
(D) To allow page headers and footers appear on document when printed 

145.  Which of the following function key activates the speller? 
  (A) F5 (B)  F7 (C)  F9 (D) Shift + F7 
146.  The minimum number of rows and columns in MS Word document is? 
  (A)  1 and 1 (B) 2 and 1 (C) 2 and 2 (D)  none of above 
147.  Thesaurus tool in MS Word is used for? 
  (A) Spelling suggestions   (B) Grammar options 
 (C) Synonyms and Antonyms words  (D) All of above 
148.  Why Drop Caps are used in document? 
  (A)  To drop all the capital letters  

(B)  To automatically begin each paragraph with capital letter 
(C) To begin a paragraph with a large dropped initial capital letter 
(D) None of above 

149.  A bookmark is an item or location in document that you identify as a name for future reference. 
Which of the following task is accomplished by using bookmarks? 

  (A) To add anchors in web page 
(B) To mark the ending of a paragraph of document  
(C) To quickly jump to specific location in document  
(D) To add hyperlinks in webpage 

150.  A word processor would most likely be used to do? 
  (A)  Keep an account of money spent 

(B) Do a computer search in media center 
(C)  Maintain an inventory (D) Type a biography 

151.  What happens when you click on Insert >> Picture >> Clip Art? 
  (A)  It inserts a clipart picture into document 
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(B)  It lets you choose clipart to insert into document 
(C) It opens Clip Art taskbar  (D)  none of above 

152.  Which option is not available in Insert Table Auto fit behavior? 
  (A) Fixed Column Width (B) AutoFit to Contents 

(C) Auto fit to Window (D) Auto fit to Column 
153.  To auto fit the width of column? 
  (A) Double click the right border of column (B) Double click the left border of column 

(C) Double click the column header  (D)  All of above 
154.  From which menu you can insert Header and Footer? 
  (A) Insert Menu (B)  View Menu (C) Format menu (D)  Tools Menu 
155.  After typing header text, how can you quickly enter footer text? 
  (A) Press Page Down key and type the text for footer  

(B)  Click on Switch between Header & Footer then type the text 
  (C) Both of above  (D)  None of above 
156.  When inserting Page number in footer it appeared 1 but you wish to show a. How can you do that? 
  (A) From format menu choose bullets and Numbering and configure necessary setting 

(B) From Insert menu choose Page Number and specify necessary setting 
(C) Click on Page Number Format tool and specify required setting (D) All of above 

157.  Which of the following statement is false? 
  (A)  You can set different header footer for even and odd pages 

(B)  You can set different page number formats for different sections 
(D)  You can set different header footer for first page of a section 
(D) You can set different header and footer for last page of a section 

158.  Where can you change the vertical alignment? 
  (A) Formatting toolbar (B) Paragraph dialog box (C) Page Setup dialog box (D) Standard toolbar 
159.  To get to the ‘Symbol’ dialog box, click on the ______ menu and choose ‘Symbol’. 
  (A)  Insert  (B)  Format  (C)  Tools (D)  Table 
160.  Which of the following symbol sets would be most likely to contain a mathematical symbol such as a 

degree sign, greater than or equal to, or a Greek letter? 
  (A) Wingdings (B) Wingdings 3 (C)  Webdings (D)  Symbol 
161.  When assigning a shortcut key to a symbol, you should always try to select a key or key combination 

that is: 
  (A)  Unassigned (B) Located on the ten-key pad section of your keyboard. 
  (C) Assigned to another task. (D)  From the same font family as the symbol. 
62.  Suppose you wanted to create an AutoCorrect entry that would type the words ‘We regret to inform 

you that your submission has been declined’ Of the following choices, which would be the best 
name you could assign to this entry? 

  (A)  Regret  (B) Subdual  
(C) ) We regret to inform you that your submission has been declined (D)  11 

163.  If you want to convert a symbol or several lines of text into an AutoCorrect entry, you should: 
(A) Insert the symbol or type the text in a Word document first. Then, select the text or symbol 
and go to the AutoCorrect dialog box. 
(B) Click the Tools menu and choose AutoCorrect Options. Then, click the Insert menu and 
choose Symbol (or click the Format menu and choose Paragraph) to add the symbol or paragraph to 
AutoCorrect. 
(C) AutoCorrect can only accommodate one line of text. It is not possible to convert a symbol or 
multiple lines of text into an AutoCorrect entry. 
(D) Insert the symbol or type the text in a Word document first. Then, select the text or symbol 
and click the Edit menu followed by Paste Special. Select New AutoCorrect Entry and then click OK. 

164. AutoCorrect was originally designed to replace _________ words as you type. 
  (A) Short, repetitive (B) Grammatically incorrect (C) Misspelled (D) None 
165.  Which of the following is the second step in creating a macro? 
  (A) Start recording 

(B) Using your mouse or keyboard, perform the task you want to automate 
(C) Assign a keyboard shortcut to the macro (D) Give the macro a name 



Prof. M. Javed Akhtar  In the name of ALLAH M S  W O R D  2 0 1 0  

P a g e  | 47 03083357385 Anwar Majid 
 

166.  If you will be displaying or printing your document on another computer, you’ll want to make sure 
and select the _____________ option under the ‘Save’ tab. 

  (A) Embed Fonts (B) Embed True Type Fonts (C) Save True Type Fonts (D) Save Fonts 
167.  In Word, the mailing list is known as the ____________. 
  (A) Data sheet (B) Source (C)  Data source (D)  Sheet 
168.  Which of the following is not one of the three ‘Mail Merge Helper’ steps? 
  (A) Merge the two files  (B) Create the main document 

(C) Set the mailing list parameters (D) create the data source 
169.  Which of the following button will allow you to add, delete, or change records in your Data Source? 
  (A) Data Source’ button (B) ‘Edit’ button (C) ‘Edit Data Source’ button (D) ‘Data editing’ button 
170.  It is possible to _______ a data source before performing a merge. 
  (A)  Create  (B)  Modify  (D)  Sort (D)  all of the above 
171. What is the default font size of a new Word document based on Normal template? 
  (A) 10 pt.  (B) 12 pt.  (C) 14 pt. (D) None of above 
172.  What is the default font used in MS Word document? 
  (A) Times New Roman (B)  Arial (C)  Algerian (D) Preteen 
173.  Which tab in Font dialog box contains options to apply font effects? 
  (A) Font tab (B) Character Spacing (C) Text Effects  D) Standard Toolbar 
174.  If you need to double underline a word, how will you do that? 

(A)  Go to Format menu and then Font option. Open Underline Style and choose Double 
Underline 
(B) From Format menu choose Font option and then from Font tab open Underline Style and 
select Double Underline 
(C)  Select the text then choose Format >> Font and on Font tab open Underline Style and 
choose Double Underline (D)  Click double underline tool on formatting toolbar 

175.  Drop Cap means? 
  (A)  All Caps (B) Small Caps (C) Title case (D)  None of above 
176.  What is the short cut key to open Font dialog box? 
  (A)  Ctrl + F  (B) Alt + Ctrl + F (C) Ctrl + D  (D) Ctrl + Shift + D 
177.  How can you access the font size tool on formatting toolbar? 
  (A)  Ctrl + S  (B)  Ctrl + Shift + S (C) Ctrl + P  (D) Ctrl + Shift + P 
178.  How can you make the selected character superscripted? 
  (A) Ctrl + =  (B) Ctrl + Shift + = (C)  Alt + Ctrl + Shift + = (D) none 
179.  What does Ctrl + = key effect? 
  (A) Superscript (B)  Subscript (C) All Caps  (D) Shadow 
180.  What happens if you mark on Hidden check box of Font dialog box after you select some text? 
  (A)The text is deleted from document and you need to bring from Recycle Bin if required again. 
  (B) The text is hidden and you need to bring it by removing the check box if needed again 

(C) The text is deleted and cannot be returned back  
(D)  The text is hidden and cannot be returned back 

181.  How can you increase the font size of selected text by one point every time? 
  (A) By pressing Ctrl +] (B) By pressing Ctrl + [ (C) By pressing Ctrl +} (D) By pressing Ctrl + { 
182.  Which of the following line spacing is invalid? 
  (A)  Single (B) Double  (C)  Triple  (D) Multiple 
183.  How can you apply exactly the same formatting you did to another text? 
  (A) Copy the text and paste in new location. Then type the new text again. 

(B) Copy the text and click on Paste Special tool on new place 
(C) Select the text then click on Format Painter and select the new text (D) all of above 

184.  What should you do if you require pasting the same format in many places? 
(A) Click the Format painter and go on pasting in many places holding Alt Key 
(B) Double click the format painter then go on pasting in many places 
(C) Click the format painter then go on pasting to many places holding Ctrl Key (D) all 

185.  On which toolbar can you find Format Painter tool? 
  (A) Standard toolbar (B) Formatting toolbar (C) Drawing Toolbar (D) Picture Toolbar 
186.  Which indent marker controls all the lines except first line? 
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(A) First Line Indent Marker  (B) Left Indent Marker 
(C) Hanging Indent Marker  (D) Right Indent Marker 

187.  How can you remove tab stop markers from ruler? 
  (A) Double click the tab marker and choose Clear All 

(B) Drag the tab stop marker out of the ruler 
(C) Right click the tab stop marker and choose remove (D) all of above 

188.  Which operation you will perform if you need to move a block of text? 
  (A)  Copy and Paste (B)  Cut and Paste (C) Paste and Delete (D) Paste and Cut 
189.  What is the extension of Word files? 
  (A)  FIL  (B)  DOT  (C) DOC (D)  TXT 
190.  Which of the following option is not available in Insert >> Picture? 
  (A)  Chart  (B)  Word Art (C) Clip Art (D) Graph 
191.  To insert a drop cap in one of the paragraph you should access? 
  (A) Insert Menu (B) Format  (C) Tools (D) None of above 
192.  How many different positions can you set for drop cap? 
  (A)  1  (B) 2  (C) 4 (D)  6 
193.  What is the maximum number of lines you can set for lines to drop box? 
  (A)  3  (B)  5  (C)  10 (D) 15 
194.  Which of the following can NOT be used to create parallel style column? 
  (A)  Format Tabs (B)  Table Insert Table (C) Insert Textbox (D) Format Columns 
195.  Which of the following is used to create newspaper style columns? 
  (A) Format Tabs (B) Table Insert Table (C) Insert Textbox (D) Format Columns 
196.  Columns dialog box can be opened from? 
  (A)  Format menu Columns submenu (B)  Double click on column space in ruler 

(C) Press Alt + O + C   (D)  All of above 
197.  You can jump to the next column by? 
  (A) Clicking with your mouse on the next column (B)  Press Alt + Down-arrow 

(C) Both of above     (D) None of Above 
198.  How can you break the current column and start a new column immediately by pressing? 
  (A)  Ctrl + Shift + Enter (B) Alt + Enter (C)  Ctrl + Enter (D) Alt + Shift + Enter 
199.  What is the smallest width of a column? 
  (A)  0a  (B)  0.5a  (C)  1a (D) 1.5a 
200.  If the number of columns is selected 1 and the line between checkbox is marked, where is the line 

drawn? 
  (A) In the left margin (B) in the right margin (C) both in left and right margin (D) none  
201.  The other Col # is inactive when you’ve select 3 columns. How will you activate those boxes? 
  (A) double click on spacing box (B)  double click on inactive Col # 

(C) Remove mark from Line between checkbox  
(D) Remove mark from Equal Column Width check box 

202.  How much space in minimum must be provided between columns? 
  (A)  0a  (B)   0.5a   (C)  1a (D)  1.5a 
203. To open Columns dialog box quickly? 
  (A) Double click on the left margin area of ruler 

(B) Double click the space between areas on ruler 
  (C) double click the right margin in ruler  (D) all of above 
204.  Which of the following command is not available in Tools menu? 
  (A) Auto text (B)  Autocorrect (C) Auto summarize (D)  Macro 
205.  To move the cursor page to page of document? 
  (A) Ctrl+ Page down (B)  Ctrl+ Page up (C) Both of above  (D) none  
206. Text boundary can be displayed or hidden from? 
  (A)  Auto text option from Insert menu (B) Options from Tools menu 

(C) Customize from Tools menu  (D)  all of above 
207.  Which of the following is word processing software? 
  (A)  WordPerfect (B)  Easy Word (C)  MS Word (D) All of above 
208.  MS Office provides help in many ways, which of these is one of them? 
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  (A)  What is this? (B) Office Assistant (C) Help menu (D) All of the above 
219.  You wished to justify text over the height of paper, which option wills you choose? 
  (A) Page Setup from File menu (B)  Paragraph from Format menu 

(C)  From formatting toolbar (D)  Font from Format menu 
220.  Which of the following is not of the merge process? 
  (A) Sort the data source records (B)  Format a main document 

(C)Edit a data source   (D) Merge the two files to print or create a new document 
221.  There can be many ways to insert page number in a document. Which of the following lets you to 

insert page number? 
(A) Page number from Insert menu (B)  Page Setup from file menu 
(C)  Footnote from Insert menu (D)  both a & c 

222.  Which is not a data source component? 
(A) Mail merge toolbar (B)  header row (C)  data fields (D) data records 

223.  Which of the following is not the part of standard office suite? 
   (A) Word Processor  (B)  Database (C)  Image Editor (D) File manager 
224.  Where can you find the Draw Table tool button? 

(A) Standard toolbar (B) Formatting toolbar (C) Drawing toolbar D) Tables and formatting toolbar 
225.  Which of the following option in File pull down menu is used to close a MS Word document? 

(A) Quit (B)  Close (C)  Exit (D)  New 
226.  You need to jump to the next column breaking current column right at the cursor position. How can 

you break column? 
(A) Pressing Ctrl+ Enter   (B) Pressing Alt+ Shift+ Enter 
(C) Break command from Insert menu  (D) both b and c 

227.  Superscript, subscript, outline, emboss, engrave are known as? 
(A)  Font styles (B) font effects  (C)  word art (D)  text effects 

228.  Shimmer, Sparkle text, Blinking Background etc. are known as? 
  (A) Font styles (B)  font effects (C)  word art (D)  text effects 
229.  The feature of Word that automatically adjusts the amount of space between certain combinations 

of characters so that an entire word looks more evenly spaced. What is that feature called? 
  (A) Spacing  (B)  Scaling  (C) Kerning  (D) Positioning 
230.  Which of the following is not available in Font Spacing? 

(A) Normal  (B) Loosely  (C) Condensed (D) Expanded 
231.  Which of the following position is not available for fonts on MS Word? 

(A) Normal  (B)  Raised  (C) Lowered (D) Centered 
232.  What is the maximum scale percentage available in Scale drop down box? 

(A) 500  (B)  200  (C)  100  (D)  90 
233.  Bold, Italic, Regular are known as? 

(A)  Font styles (B) font effects (C) word art (D) text effects 
234.  Uppercase on Change Case dialog box and All Caps on Fonts dialog box both converts selected text 

into Capital Letters. What’s the difference between the two? 
  (A) Both are same. They are only two different ways of capitalize text. 

(B)  It is faster to convert from Change Case than from Font dialog box 
(C)  Change Case makes conversion permanent but All Caps on Font can always be reverted 
(D)  All Caps on Font dialog box makes the change permanent where Change Case can be always 
reverted 

235.  If you need to hide some paragraphs, how can you do it? 
  (A) From Paragraph dialog box (B) From Font dialog box (C) From Options Dialog box (D) None 
236.  Which of the following is the latest version of MS Word? 
   (A) Word 2000 (B)  Word 2007 (C)  Word 2010 (D)  Word 2011 
237.  Changing the appearance of a document is called? 

(A)  Proofing (B) Editing  (C) Formatting (D) All of above 
238.  In a document what is the maximum number of columns that can be inserted in MS Word Table? 
  (A) 35  (B)  15  (C)  63  (D) 65 
239.  You can detect spelling and grammar errors by pressing? 

(A)  Shift + F7 (B) Ctrl + F7 (C) Alt+ F7  (D)  F7 
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240.  A screen element of MS Word that is usually located below the title bar that provides categorized 
options is 

  (A) Menu bar (B) Tool bar (C)  Status bar (D) All of the above 
 

Any error or mistake is always welcomed by the Prof. M. Javed Akhtar 


